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1. INTRODUCTION

The Deployed Theater Accountability Software (DTAS) application provides the U.S. Army and
the U.S. Marine Corps with a reliable, timely, and efficient mechanism for tracking and
providing reporting visibility into the location and duty status of deployed Soldiers at both the
Enterprise level (top of the system) and the unit level (bottom of the system). This visibility is
vital in determining war fighting capability.

In support of the DTAS vision, this project controls the work effort to meet the following
objectives:

e Develop a standard Army system for deployed personnel accountability
e Improve data quality

e Establish a common picture

e Perpetuate deployed personnel accountability

DTAS enables commanders in deployed theaters to account for DoD personnel in their areas of
operations by name (SSN), unit, location, and day. DTAS comprises three components: the
Enterprise, Theater, and Mobile systems.

The DTAS Enterprise system houses the central database, which contains soldier data obtained
from eMILPO as well as information on current soldier location and duty status as entered into
the Mobile systems and passed to the Enterprise system. The Enterprise system also interfaces—
through a secure high assurance guard (HAG)/trusted gateway—with eMILPO and receives data
from the Defense Manpower Data Center (DMDC) and Operational Data Store Enterprise
(ODSE). In addition, the Enterprise system includes an integration broker that manages the
messaging among DTAS component systems. The Enterprise system also houses a data
warehouse that contains historical data for each deployed soldier, such as a transaction history of
those attributes for which DTAS is the authoritative source. Ad hoc reporting and the
JPERSTAT are configured to run against the DTAS Enterprise data warehouse.

The Theater system consists of the Theater Manager application and a core database. The
Theater database is a subset of the Enterprise system. The Theater system communicates with
both the Enterprise and Mobile systems. Message Queuing is used for communications between
the Theater and Enterprise systems. The Theater system uses Web Services to support data
communications with occasionally connected DTAS Mobile systems. The Theater Manager
application allows theater-level users to manage mobile systems and UIC structure. The Theater
system also provides reporting capabilities, such as the JJERSTAT report and support for ad hoc
queries.

The Mobile system provides the First Sergeant/Company (1SG/CO) level with a micro-database,
reporting capabilities, and personnel accounting tools. The Mobile database contains
information on the soldier’s current location and duty status as well as a mini-record. The
Mobile system allows the user to update location, duty status, personnel information, DUIC, and
tour status. In addition, the system provides several predefined, roster-based reports. The
Mobile system is deployed on laptop computers and uses Web Services because these systems

Draft November 14, 2005
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may only occasionally be connected to the network. While a Mobile system is disconnected, any
DTAS work performed is stored in a message in its micro-database. When the Mobile system is
connected, the stored messages are sent to the Theater via Web Services.

Note: DTAS displays the SSN for an individual in several instances, such as on the People tab
screen. The SSN has been removed from all screen captures contained in this document for
privacy reasons. Therefore, some screens will appear differently in the document than they will
on your system: For example, a table column that would be populated on your system will
appear blank in the screen captures.
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1-2
FOR OFFICIAL USE ONLY



DTAS Mobile Application User Manual CM No. DTAS-MAUMO0-010-20051114

2. DTAS MENUS

DTAS includes the following menu choices: File, View, Tools, and Help. Each menu provides
you with a set of functions that enable you to exit the system, view synchronization data, etc.

2.1 File Menu

You may exit the DTAS application from the File menu. To exit DTAS, select Exit from the
File menu (or click the X in the upper right-hand corner of the window).

§I=H View

Exit
Figure 2-1: DTAS File Menu

2.2 View Menu

The View menu allows you to select the view for your branch of service. The default view for
the application is whichever DoD component was identified when your Mobile system was
activated. The menu provides you with the following options:

e Army—This option allows you to select the Army view of the DTAS Mobile application.
e Marine—This option allows you to select the Marine view of the DTAS Mobile

application.
N Tools
W Army
Marine
Figure 2-2: DTAS View Menu
2.3 Tools Menu

The Tools menu provides you with the following options:

e Mass Add Wizard...—The Mass Add Wizard allows you to add personnel from a TPS
TRN file, an eMILPO Load, or a.CSV file.

e System Info ...—The System Info provides information related to the system
configuration, such as System POC Name, System POC Phone Number, System DUIC,
and System Activation Date.

e Deactivate System...—The Deactivate System function resets the theater system. This
function will delete all personnel from the database and delete theater-specific
information.

e View Synchronization Info...—This function allows you to view system messages and
synchronization information.

e CSV File—This function allows you to create and edit an Excel spreadsheet that is saved
as comma delimited file for upload via the Mass Add Wizard.

Draft November 14, 2005
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Mass Add Wizard ...
Syskem Info ...

Deactivate System ...

Wiew Synchronization Info ..

Mew
Edit

Figure 2-3: DTAS Tools Menu

2.31 Mass Add Wizard

The Mass Add Wizard function allows you to load data to your DTAS database using an
eMILPO XML load file, a TPS TRN file, or a CSV file. The XML and TRN files are created in
eMILPO or TPS, respectively, and are saved to a floppy disk or other removable/transportable
media. To load data from a file, perform the following steps:

1. Select Mass Add Wizard... from the Tools menu. DTAS displays the Mass Add Wizard
dialog.

Mass Add Wizard A=l
Help

Select aSource File

Drata can be loaded from an ebdILPO =ML load fle, a TPS TRH file ar a CS5Y file.

File M arme;

Select File...
‘ : | Cancel |

Figure 2—-4: Mass Add Wizard—Select a Source File

2. Click the Select File button to select the file. DTAS displays the Open dialog box. Navigate
to the folder location of the file you wish to upload. Highlight the file and then click Open or
double click on the file to select it. DTAS displays the file name and path on the dialog and
activates the Next button. Click Next to proceed.
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Mass Add Wizard =3
Help

Select aSource File

[Data can be loaded from an ebILPO XML load file, a TPS TRM file ar a C5Y file.

File Mame:  D:A\Daocument: and Settingzhrz3fnd AMER My
Documentz\DTASAile scriptzhB5d_ JOINT_THRM. bt

Select File...
] Mest = | Cancel |

Figure 2-5: Mass Add Wizard—Source File Selected

Note: If the file you select is not of the appropriate type (either an XML, a TRN, or a CSV
file), DTAS displays a message informing you that the file is not in the proper format. Click
OK to return to the Mass Add Wizard dialog.

Mass Add Personnel - CSY

@ The file must be an eMILPO load file or TRM data File or C3% data File,

Figure 2—-6: Mass Add Wizard—File Error Message

Note: When adding personnel from a CSV file, the Mass Add Wizard will not load records
that are missing data or contain errors. The Mass Add Wizard will only load
complete/accurate records; any records containing errors will not be loaded. You will be
unable to load information for these persons until you correct the errors. If your CSV file
contains errors, the system displays an error message (shown below) informing you that the
file contains errors as well as the location of the error log file.
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"_\ There were error(s) on the selected C3V File.

To review error(s), open File:
W INDONY S Temph C3vLoadErrorFile, bxk

Figure 2-7: Mass Add Wizard—CSV File Error Message

The error log file provides information on what values are missing and in which record
(corresponds to the rows of the spreadsheet). To correct the CSV file: from the Tools menu,
select CSV File and then Edit (see Section 2.2.5, CSV File, for additional information).

B CSVLoadErrorFile.txt - Notepad

File Edit Format View Help

(Processed pate: 1,/13/2005 6:21:57 PM
Processed File: D:i“ZDocuments and Settingshywrz9fnd. AMERMMy DocumentshDTASNFile scriptshCsvTemplate_ tmp79. csv
pProcessed By: rzgfnd

1 - pob Component cannot be null in record 3.

Figure 2-8: CSV File Error Log

3. DTAS displays the Select People to Load dialog box.

4. By default, all records are selected. Click Select All to select all records or you can select
individual records by clicking the check box to the left of each record to select individual
records you wish to load. You can also click Deselect All to deselect all the records or you
can deselect individual records by clicking the checkbox to the left of the record.
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Mass Add Wizard
Help

Select Peopleto Load

One or more people can be added,

v ACOSTA, ANGELA

-
v ADKISSOM, MARQUIS —
v AHERM, COLIN

W ALLEM, DEMA b

Select Al ‘ Deselect Al |

¢ Back ] Mest > | Cancel ‘

Figure 2-9: Mass Add Wizard—Select People to Load

5. Click Next to proceed. The application displays the Select Arrival Date/Time and Operation
data (or if adding personnel from a CSV file, the Select Operation Data) dialog.

Mass Add Wizard
Help

Select Amival Date/Time and Operation data

“Operatior; | Select Ore -l

“Arrival D atedTime: |2EIEIEEIE|1 412050 GMT-5:00 ﬂ

Re-enter &rrival D abeTime: | 14 | Gk J

< Back ‘ Mewxt » | Cancel ‘

Figure 2-10: Select Arrival Date/Time and Operation Data Dialog

Draft November 14, 2005
2-5
FOR OFFICIAL USE ONLY



DTAS Mobile Application User Manual CM No. DTAS-MAUMO0-010-20051114

Mass Add Wizard WELE

Help

Select Operation data.

“Operation; | Select One j

¢ Back | et » | Cancel

Figure 2-11: Select Operation Data Dialog

6. Select the name of the operation to which the personnel are being added from the Operation
picklist. This is a required field.

7. The Arrival Date/Time picklist defaults to what has previously been entered for the arrival
date and time (the Arrival Date/Time field is not displayed for CSV files). If you enter an
Arrival Date/Time that is 30 or more days old, DTAS enables the Re-enter Arrival
Date/Time field and you must re-enter the arrival date and time. Note: The arrival date and
time cannot be a date greater than 4 years old.

For CSV files, if the Arrival Date/Time is not a valid arrival date and time, the Arrival
Date/Time field defaults to the current system date and time.

8. Click Next to proceed with the load process. DTAS displays the Select Assigned and
Physical Location dialog.
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Mass Add Wizard =0/
Help

Select Aszigned and Physical Location

Pleaze select one Azzigned Location.

Azsigned Phyzical
“Location; | Select One j “Type: |SPECIFIC |
Locatian: |F'h_l,l$i-:a| Locations ﬂ
e | - | J nggigr?aﬂtgﬁ Eu:u:uru:lir:aItEEZLI,::I
T atedTime: | 1914 |

¢ Back ] Firish | Cancel ‘

Figure 2-12: Mass Add Wizard—Select Assigned and Physical Location (XML
and TRN Files)

Mass Add Wizard
Help

Select Assigned and Physzical Location

Fleaze select one Azsigned Location,

Agzigned Physical
“Location; | Select One - Type: |SPECIFIC -
Laocation: |F'h_l,lsi|:al Locations LJ

*Grid Zone “Grid

D esignatar: Coordinates:

< Back ‘ Firish | Cancel ‘

Figure 2-13: Mass Add Wizard—Select Assigned and Physical Location (CSV
Files)

9. Inthe Assigned area, select an Assigned location from the Location picklist. DTAS defaults
the Date/Time field to the current date and time.

10. In the Physical section, select the type of location from the Type picklist.
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11. Select a location from the Location picklist. DTAS defaults this to the Assigned location you
selected in the Assigned data entry area. The Assigned and Physical locations can be
different.

12. You may edit the Grid Zone Designator (this must be two letters) and the Grid Zone
Coordinates (this must consist of six or eight numbers). These fields are populated with the
designator and coordinates for the Assigned location value if the Assigned and Physical
locations are the same. If the Assigned and Physical location differ, DTAS populates the
Grid Zone Designator and Grid Zone Coordinates with the values associated with the
Physical location.

13. Click Finish to load the data into the database.
14. Click Back to return to the previous step in the process.
15. Click Cancel to exit the process without adding data.

2.3.2 System Info

The System Info function provides you with contact and activation date information related to
your DTAS system. To view information related to your system, perform the following steps:
Select System Info from the Tools menu. DTAS displays the System Info dialog box. Click
Close when you are finished. DTAS closes the dialog box and returns you to your previous
screen location.

System Info

Syztem POC M ame: |

Syztem POC Phane: |

Syztem DUIC:

Syztem Activation Date: |

Cloze

Figure 2-14: System Info Dialog

2.3.3 Deactivate System

The Deactivate System functions allows you to reset your system. The function removes the
existing database. To deactivate a system, select Deactivate System from the Tools menu.
DTAS displays the Deactivate System confirmation message. Click OK to proceed with the
process. Note: This will remove the existing database, deleting all your data. Click Cancel to
cancel the deactivation without making any changes.
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Deactivate System [z|

! personnel From the database, remove any theater specific data, and no

T You are abouk to Deactivate the system, Doing so will remove all
L

longer allow you ko run DTAS, Are wou sure vou wank bo Deactivate?

(.4 | Zancel

Figure 2-15: Deactivate System Message

234 View Synchronization Info

The View Synchronization Info function allows you to view system-generated messages
awaiting upload to the Theater system and a synchronization log that details the synchronizations
sent between the Mobile and Theater systems. To view synchronization information, select
View Synchronization Info from the Tools menu. DTAS displays the Synchronization Info
window. The window contains two tabs, Message Queue and Synchronization Log. DTAS
defaults the display to the Message Queue. To change the display, click the Synchronization
Log tab, and DTAS displays the log. The information displayed is read-only. Click Refresh to
update the display to show the most recent data. In addition, on the Synchronization Log tab you
can specify how many rows are displayed in the window by selecting from the Row Height
picklist. When you are finished viewing the information, click Close. DTAS returns you to your
previous screen location.

] Synchronization Info

teszage Dusue ] Sunchronization Log l

tessage Typ| Message Statug Creation Date  ~

» 10 <Ml version="1.0" encoding=""utf-16""7?> F: a/24,/2004 203 P
<DutyStatusUpdateT ype wmine:wed="http: /Awwn w3, org/ 2007 LS ch
<M ezsageNumber: 231 < /MeszageMumber:

<GUID: <GUID:
<GDUIC />
1001 <Pl version="1.0" encoding=""utf-16""?> F: /24,2004 203 P

<DutyStatusUpdateT ype wming:sed="http: /Awwi w3, org/ 2007 S<MLS ch
<M ezsageMumber: 229< /Mezzageumber:

<GUID: </GUID e
<GDUIC />
100 < Puml version="1.0" encoding=""utf-16""7> F 8/24,/2004 403 P

<DutyStatuzUpdateT ype smins:xed="http: /s w3, org/ 2001 Z<5MLS ch
<M ezsageMumber: 227 < /MezzageMumber>

<GUID: <AGUID:
<GDUIC />
1o < Pwml version="1.0" encoding=""utf-16" 7> F 8/24,/2004 403 P

<DutyStatuzUpdateT ype wmins:xed="http: /s w3 org/ 2001 Z<5MLS ch
< M ezsageMumber: 220< /MeszageMumber:
<GUID> <AGUID:
<GDUIC />
1o < Ml version="1.0" encoding=""utf-16""?> F: a/24,/2004 403 P
<DutyStatusUpdateT ype wmins:ad="http: / Awwn w3.org/ 2001 LS ch
< M ezsageNumber: 223< /MeszageMumber:

<GUID: <MGUID:
] <GOUIC &
10Mm <Pl vergion="1.0" encoding="ut-16"7> F 8/24/2004 403 P T
'l ] »
Refrezh ‘ Cloge |

Figure 2-16: Message Queue
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= Synchronization Info

Meszage Quewe  Swnchronization Log
[ate Time Mezzage

» - 2004-08-24 15:54:03  Swcn Timer gt to: 60000 milizeconds.
. 2004-08-24 12:54:03  Pulse Timer zet to: B0000 miliseconds.
| 2004-08-24 15:54:03  Service Started.
| 2004-08-24 155506 Server ushiz917 iz available.
. 2004-08-24 15:55:06  Server uzhrs317 iz available.
- 2004-08-24 15:85:07  Session Token Received: leLnhjlIfs+..
| 2004-08-24 15:55:07  BEGIM: SYNCHROMIZATION
. 2004-08-24 15:55:07  Theater Server iz Available.
. 2004-08-24 15:5009  Requesting Update from Server.
. 2004-08-24 15:55:15  Received [0) Updates.
- 2004-08-24 15:585:17  Rows Allowed set to: 100 meszages.
. 2004-03-24 155518 Uaing Batch Mumber; 830
.2004-08-24 15:80:18  Selected: (0] Type: 1003 Meszsages for send.
-2004-08-24 15:85:18  Selected: (0] Type: 1008 Messages for send.
.2004-08-24 15:55:18  Selected: (0] Type: 1005 Mezsages for send.
.2004-08-24 15:85:18  Selected: (0] Twpe: 1007 Messages for send.
.2004-08-24 15:55:18  Selected: (0] Type: 1001 Messages for send.

NAANE.2A 1R-ERAD  Calackad (M Toma: 1007 Macsanss for sand
Row Height: I@ Refresh I Cloze I

EEX]

Figure 2-17: Synchronization Log

2.3.5 Comma Separated Values (CSV) File

The CSV File function allows you to create or edit an Excel spreadsheet that can be used for data
entry and upload to DTAS. The Excel spreadsheet is saved in a comma delimited format (.CSV
file) that you can use to upload data using the Mass Add Wizard function. The CSV File
function consists of submenu with two options: New and Edit. An example of the file format is
provided below. Note: Required fields are denoted by an asterisk.
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A, =] c 8] E F G H J Ko 5
] | ] T ] ] ] b ]
Foreign
“Last “First Do Service Military
1 | Carrier *SSN Name Name Ml “Sex *Service Component  Component | Indicator RUC ULN
2 L]
3
4
5 1
G
7
8 4

Figure 2-18: Left Portion of the CSV Template

- i o | P | a | R | 5 | T 5] K LW ! | i
b
Arrive
Depart Depart | Arrive Date Time Birth Date Duty

1 MOS Rank TRUC APOE APOD Date Time | (YYYYMMDD} (hh:mm:ss) (YYYYMMDD) Status Blood | Marital Status
*

<

4

5 il

E il

? ]

g

Figure 2-19: Right Portion of the CSV Template

For information on the business rules associated with the CSV File function, refer to Section
2.2.5.3, Business Rules: CSV File.

2.3.51 NEw

To create a new CSV file, perform the following steps:

1. Select CSV File from the Tools menu and then select New from the submenu.
2. DTAS launches the Excel CSV file template.

3. Enter data directly into the spreadsheet cells. Required fields are denoted with a red flag in
the upper right corner of the column header, as shown in the close-up below. If you hover
the cursor over the red flag, additional information about the data column is provided.
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A | B i G
" |Required field for all

Service (Person

1 | Carrier “SSN Types) excepl for 1l
Foreign

% Mational/Military.
4
5

Figure 2-20: CSV File Pop-Up

The following fields are available for data entry:

Carrier—This is the organization that provided transportation for the individual.

SSN (Social Security Number)—This is the individual’s Social Security number. The
field requires nine numeric characters.

Last Name—Data entry is not limited in Excel; however, the database field is limited to
30 alpha characters.

First Name—Data entry is not limited in Excel; however, the database field is limited to
30 alpha characters.

MI (Middle Initial)—Data entry is limited to one alpha character.
Sex—Enter M for male and F for female.

Service—This field corresponds to the People Type field in the DTAS database and
denotes the organization with which the individual is associated. Data entry is made
through a picklist.

DOD Component—This field is for designating the branch of the Department of
Defense for whom the soldier or DoD civilian works. Data entry is made through a
picklist.

Service Component—This field is for designating whether the soldier is Active,
Reserve, or Guard. A fourth data entry option of Unknown is available to the user. Data
entry is made through a picklist.

Foreign Military Indicator—This is a yes/no indicator of whether the individual is with
a foreign military or is a foreign national. Selection is made through a picklist.

RUC (Reporting Unit Code)—The RUC is the Marine Corps code for the soldier's
deployed unit. This code is analogous to the DUIC in DTAS. The code consists of five
alphanumeric characters.

ULN (Unit Line Number)—The ULN is a line item number that corresponds to the
MOS. Each unit has a table of organization that lists each soldier by unit line number.

MOS (Military Occupational Specialty)—This identifies the soldier’s MOS, which is a
group of duty positions of close occupational or functional relationships that facilitate
interchangeability among persons of various skill levels. Data entry consists of three
alphanumeric characters for the Army, and four numeric characters for the Marine Corps.
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Rank—This field indicates the soldier’s current rank. The rank should be entered as an
abbreviation, such as SSG for Staff Sergeant.

TRUC (Temporary RUC)—The TRUC is a temporary unit to which a Marine is
attached; it is used for temporary duty assignments.

APOE (Air Port of Embarkation)—This is the part from which the individual last
departed en route to theater.

APOD (Air Port of Debarkation)—This is the individual’s point of arrival in theater.

Depart Date—This is the date the individual departs the APOE. Data entry must be
numeric characters. Data entry should be eight numeric characters, including four-digit
year, two-digit month, and two-digit day.

Depart Time—This is the time the individual departs the APOE. Data entry must be
numeric characters. Data entry should be six numeric characters, including two-digit
hour, two-digit minutes, and two-digit seconds.

Arrive Date (YYYYMM DD)—This is the date the individual arrives at the unit. DTAS
defaults this to the system date. Data entry should be eight numeric characters, including
four-digit year, two-digit month, and two-digit day.

Arrive Time (hh:mm:ss)—This is the time the individual arrives at the unit. DTAS
defaults this to the system date. Data entry should be six numeric characters, including
two-digit hour, two-digit minutes, and two-digit seconds.

Birth Date (YYYYMMDD)—This is the individual’s date of birth. Data entry should
be eight numeric characters, including four-digit year, two-digit month, and two-digit
day.

Duty Status—This is the current duty status for the individual. DTAS defaults the status
to PDY, Present for Duty, during the Mass Add Wizard process.

Blood—Enter the individual’s blood type by selecting the code that corresponds to the
blood type. Selection is made from a picklist which includes the following options:

— A denotes A+ blood type
— B denotes A- blood type

— C denotes B+ blood type
— D denotes B- blood type

— E denotes O+ blood type
— F denotes O- blood type

— G denotes AB+ blood type
— H denotes AB- blood type

Marital Status—Enter the current marital status for the individual. Selection is made
from a picklist, which includes the following options:

A: Annulled

D: Divorced

I: Interlocutory Decree
L: Legally Separated
M: Married

S: Single

W: Widowed
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— Z: Unknown
5. The following fields have pull-down menus associated with them to expedite data entry:
e Service

e DoD Component

e Service Component

e Foreign Military Indicator
e Blood

e Marital Status

6. After completing data entry, select Save from the File menu to save the file. Excel displays a
message prompting you to confirm that you would like to save the file. You may perform
one of the following:

e Click Yes to save the file. Note: Ensure you save the file and that you maintain the file
in CSV format. If you do not click Yes to save your file, you will lose the data you have
entered.

e Click No to proceed without saving your changes.
e Click Cancel to return to the spreadsheet and make further changes.

Microsoft Excel

! "_I; Do wou wank to save the changes you made ko 'CSWTemplate_ tmpDS,csv'?

Yes Mo Zancel

Figure 2-21: Save Prompt

2.3.5.2 EDiT

To edit an existing CSV file, perform the following steps:

1. Select CSV File from the Tools menu and then select Edit from the submenu.
2. DTAS displays the Open dialog box.
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Epen 3
Lookin: | =3 file scripts ~] = BB~
4 .=._ja|:|c.d trn files
,'f3 [£] 321_OUTBOUND TRN. bet
My Recent [} 456 FOREIGN_CIV_TRM.txt
Documents  |/=Y gea JomNT TRN. bt

7 &) CsvTemplate_ tmp3iC.csv
- %:] CSyTemplate_ tmp73.csy
Desktop [ DtasFleW0010 1.3ML
[£] J0INT_TRN.bet
_J '*’g Mabile System 11.xml
I’:—j rest_org_t_load_new, txt

Wy Documents j__Jsv.zip

Iy Computer

.

Mfol'letwork File name: | LJ Open
aces
Files of typs: | LJ Cancel

Figure 2-22: Open Dialog

3. Enter the changes you want and save the file. Select Save from the File menu to save the
file. Excel displays a message prompting you to confirm that you would like to save the file.
Click Yes to save the file. Click No to proceed without saving your changes or click Cancel
to return to the spreadsheet and make further changes.

2.3.5.3

BUSINESS RULES: CSV FILE

The following business rules apply to the CSV File function:

24

If Other US Service Member or DoD Federal Civilian is selected, the DoD Component
column must be populated.

If US Army Soldier or Other US Service Member is selected, the Service Component
column must be populated.

If Foreign National/Military is selected, the Foreign Military Indicator must be populated.
If the person being added through the CSV file already exists on the local database, no
add or update will be performed for that person.

If you enter data in an invalid format (for example, Elin the Rank field rather than the
acronym), DTAS leaves that field null on the database. This applies to all fields, except
the following: SSN, Last Name, First Name, Sex, Service, DoD Component, Service
Component, Foreign Military Indicator, and Duty Status.

Help Menu

The Help menu contains the following options: About; Contents, Index, and Search for the help;
and Email Theater Manager. The About function provides information about the DTAS
application, such as the version number. You can access help by either browsing the Contents or
Index, or you can search the help file. The Email Theater Manager allows you to email the
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Theater Manager if you have issues with your system; when you select the option, DTAS
launches a blank email using your default email application.

Abouk

Contents. .. F1
Index...
Search. ..

Email Theater Manager ...

Figure 2-23: Help Menu
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3. UNKNOWN LOCATION AND DATA MISMATCH LIST

The Unknown Location and Data Mismatch List window informs you of action you must take
when persons contained within your mobile database either have an unknown location for their
Assigned Location or have a mismatch between their Person Type and their DoD Component.

DTAS checks the database every 10 minutes for persons who meet these criteria and displays the
SSNs of affected persons in list form on the Unknown Location and Data Mismatch List
window, as shown in Figure 3-1, Unknown Location and Data Mismatch List Window. If no
persons exist in your mobile database who match the criteria, DTAS does not display the
Unknown Location and Data Mismatch List window. DTAS displays the person’s information
on the Unknown Location and Data Mismatch List window until the information is corrected.
Click Close to close the window and return to the People tab screen. Note: You must close this
window before updating the information for the persons listed.

List of SSN/GUIDs that nead to List of SSN/GUIDs that

have their Assigned Location have a mismatch of data
updated because they currenthy b=twe=n Person Typs and
hawe an unknown location: Dol Component;
Q00000000 Q00000000

Figure 3—1: Unknown Location and Data Mismatch List Window

For information and procedures related to an unknown location, please see Section 3.1,
Unknown Location. For information and procedures related to a Person Type/DoD Component
data mismatch, please see Section 3.2, Data Mismatch.

3.1 Unknown Location

On the left side (shown in Figure 3-2, Unknown Location Close-Up) of the Unknown Location
and Data Mismatch List window, DTAS displays the SSNs of the persons who have an unknown
location as their Assigned Location. To be flagged for an unknown location, the person must
have an unknown country code in the database.
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List of SSM/GUIDs that need to
have their Aszigned Location
updated because they currenthy
have an unknown location:

000000000

Figure 3—2: Unknown Location Close-Up

To correct the person’s location, perform the following steps:

Highlight the SSN and press Ctrl+C to copy the SSN to the clipboard.

Close the Unknown Location and Data Mismatch List window.

Copy the SSN into the SSN lookup field.

Highlight the person and click Update Location.

DTAS defaults the Location picklist in the Assigned Location area to Select One.
Select the applicable assigned location from the picklist.

Click OK to save the changes. If you do not correct the Assigned Location, DTAS displays a
message notifying you that you must enter all required fields. Note: If you select Cancel
without correcting the Assigned Location, DTAS continues to display the person on the
Unknown Location and Data Mismatch List until you take corrective action.

No oD

3.2 Data Mismatch

On the right side (shown in Figure 3-3, Data Mismatch Close-Up) of the Unknown Location and
Data Mismatch List window, DTAS displays the SSNs of the persons who have a mismatch
between their Person Type and their DoD Component. A person is flagged for a data mismatch
if they meet the following criteria:

e |f the Person Type is US Army Soldier and the DoD Component is either null or a code
other than Army

e |f the Person Type is United States Marine, US Air Force, US Coast Guard, or US Navy
and the DoD Component code is either null, Army, or OSD
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List of SSN/GLIDs that
have 8 mismatch of data
b=tween Person Type and
Dol Component:

000000000

Figure 3-3: Data Mismatch Close-Up

To correct the person’s data mismatch, perform the following steps:

o s wh e

Highlight the SSN and press Ctrl+C to copy the SSN to the clipboard.

Close the Unknown Location and Data Mismatch List window.

Copy the SSN into the SSN lookup field.

Highlight the person and click Update Personnel.

DTAS defaults the values on the screen to those stored in the database for the person.

Select the applicable DoD Component from the picklist. Alternatively, you may also change
the Person Type by selecting the appropriate one from the picklist. If you do not correct the
Person Type or DoD Component code, DTAS displays a message informing you that the
component selected does not match the Person Type selected.

Click OK to save the changes. Note: If you select Cancel without correcting the DoD
Component mismatch, DTAS continues to display the person on the Unknown Location and
Data Mismatch List until you take corrective action.
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4, DTAS FUNCTION TABS

The DTAS application provides a streamlined interface from which you can quickly access the
tasks you need to perform. The interface presents information in a tab format (shown below),
grouping functions and tasks according to the information they serve (that is People, Location,
Reports, and Management tabs, which are discussed in Sections 5 through 8). The default
display is the People tab. To access data on other tabs, click the tab and DTAS displays that tab
in the foreground.

File “iew Tools Help

People lL-:n:atil:unsl F!Epl:urtsl Management]

Figure 4-1: Close-Up of DTAS Tabs
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5. PEOPLE TAB

5.1 Overview

The People tab displays the personnel in your UIC. You may also update personnel data, tour
status data, location data, and duty status from this tab. The People tab provides the functionality
to manage personnel records. The tab displays the personnel assigned to your UIC and their
associated information. The People tab provides the following functions:

Add Personnel
Update Personnel
Update Duty Status
Update Location
Update DUIC
Update Tour Status
Delete Person
View Mini-Record

For information about the components of the People tab and how to navigate the tab, refer to
Section 5.2, Navigating the People Tab.

5.2 Navigating the People Tab

The display of the People tab is divided into two panes. The left side of the screen displays the
UIC hierarchy. Click the plus sign to display the organization below the parent UIC. You can
repeat this as needed to get to the level of detail desired.

w-wiaPywHD BM 10

Figure 5-1: Unexpanded Tree

=R /AP HD BM 10
WO0113 COMPANY 10
WO0114 COMPANY 11
W05 COMPANY 12

Figure 5-2: Expanded Tree

The right side of the screen displays the personnel assigned to the selected UIC and their
associated data. To select a record, highlight the row in the display that lists the soldier you wish
to select. You may select multiple individuals by pressing Shift for consecutive rows and Ctrl
for nonconsecutive rows and clicking in the left-hand blank column. In addition, you may select
all records by pressing Ctrl+A. Multiple select is only available for the Update Personnel
(Operation field only), Update Duty Status, Update Location, Update DUIC, and Update Tour
Status functions.
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Clicking the Include Sub Units checkbox displays all personnel within the UIC you have selected
and any child UIC of the selected UIC. If this checkbox is not checked, DTAS displays only
those personnel in the top branch. The page displays a records count of the number of records
displayed and the number contained within the database.

The Search By fields allow you to search the listed data by SSN and Last Name. To search by
SSN, enter the soldier’s SSN or a partial SSN in the SSN field. DTAS displays the soldier’s
information or, in the case of a partial SSN, a list of SSNs that match the search criteria, as
shown below. To search by the soldier’s last name, enter the name or part of the name in the
Last Name field. DTAS displays only that soldier’s information if the full name was entered or
displays those names that match the criteria entered. To return to a full listing display, you must
clear the SSN and Last Name data-entry fields.

Deployed Theater Accountability Software [DTAS)

File Wiew Tools Help
People ] Locations I Reports I Management ]
Search By
i ) Dizplayed: 228
7 :Fﬁiltide Sub Lazt Hame; S5M: Tatal 278
CCODEE COLLEEN
Lazt Mame First Hame 55N DUIC Fank | Dty Statug Reazon Agzigned Location =
» ACOSTA AMGELA CCDDEE SPC FO CaMP HEMRY
ADKISSOMN MARQIUIS CCDDEE SGT FOY CakP HEMRAY
AHERM COLIN CCDDEE FFC PO CamP HEMRY
ALLEM DEMA CCDDEE 2T FO CaMP HEMRY
AMOAKOH MaRY CCDDEE SPC FOY CamP HENRY
AMDERSOMN ERIK. CCODDEE w01 FO CaMP HEMRY
AMDERSON  MaRCUS CCDDEE SPC FOY CamP HEMRY
AMEST STEPHEN CCDDEE ET, FOY CamP HENRY
APGER ROBERT CCDDEE SGT FO CaMP HEMRY
ARRINGTON LaviaRA CCDDEE FOY CamP EDS
AVERY JASON CCDDEE SGT FO CaMP HEMRY
BaCH WILLIERA CCODDEE  MSG FOY CamP HEMRY
BaILEY THOMAS CCDDEE FLET FOY CamP HENRY
BAMKSEWAN JASON CCDDEE SPC FO CaMP HEMRY
BARMES Daw|D CCDDEE SPC FOY CamP HEMRY
| BASMETT JARROD CCDDEE LT FO CakP HEMAY
x ¥ 4] | 3
Add |pdate Update Dty Update Jpdate Update Tour [elete Wiew Mini-
Perzonnel Ferzonnel Status Location puic Status Perzon Record
AMERYz5fnd =2 |Synchronization Complete - 9/14/2005 5:30:38 P Queued Messages: 0

Figure 5-3: Display Grid

To perform a function (except Add Personnel), highlight the soldier’s record and click the button
related to the function you wish to perform. Once you have selected an individual, you may also
select a function by clicking the right mouse button; DTAS displays a pop-up menu from which
you can select the function you wish to perform. An example of the menu is shown below.
Note: If you have selected multiple individuals for whom to perform a function, only Add
Personnel, Update Personnel (for Operation only), Update Duty Status, Update Location, Update
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DUIC, and Update Tour Status will be available when you click the right mouse button and will
be the only buttons activated.

Update Personnel ...
Update Dty Status |,
Update Location ...
Update DUIC ...
Update Tour Status ..,
Delete Person ...

‘Wiew Mini-Record ...

Figure 5-4: Right-Click Menu

To sort the table, click the header name of column you wish to sort by.

The Update DUIC is only activated for those UICs for which you have responsibility.

5.3 Add Personnel
The Add Personnel function allows you to add personnel as they are assigned to your UIC.

Clicking the Add Personnel button will launch a wizard that guides you through the data-entry
process. To add an individual, perform the following steps:

1. Click Add Personnel. DTAS displays the Add Personnel dialog box. If you would like to
add more than one person, check the Continue to Add People checkbox. This will allow you
to add more than one person without having to return to the People tab.
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] Add Personnel

Help
“Person Type:
*S5NIGUID: Birth Date: | 20051020 x. “Sex: | Select One -
“Last Name: | “First Name: Middle Name:
*Deployed UIC: [CCDDEE COLLEEN TEST | Dot VAl (50051020 10:30:26 GMT-5:00 > |
Re-enter Arrival T
Date/Time: ' J
*DoD Component:| ARMY - “Military Service[REGULAR - MOS/A0C: |
Rank: | Select One - “Operation: |Selec:t P LJ
Pay Flan: I : _J
Series: | - _]
Pay Grade: | - _J Emplayer: | - _J
Fareign Country: | : _J [ Fore
[ Continue to Add People I Mext = J Cancel I

Figure 5-5: Add Personnel Dialog (Army View)

% Add Personnel

Help
"Person Type: [[EIEINES
"SENAGUID: “Birth Date: | 20060315 x. "Sew | Select One v]
“Lazt Hame: | *First M ame: tiddle M ame:
"Deployed UIC: |CCODEE COLLEEN TEST = Dato el 20050915 17:03:10 GMT5:00 v |
Re-anter Armival[ - r
[ atedTirme: J
*DioD Component| MARINE CORFS = e gsrf]\ggﬂﬁmumn - PMOS:]
Flank:lSehBCl Ore - "0 peration:; |SB|BCI Ore LJ
Pay Plan: I _]
Series:] _J
Pay Glade:l _J Emplnyer:] =zt _]
Foreign I:Duntl_l,l:l _J [/ Fore
[ Cortinue to Add Peaple I Mext > ‘ Cancel J

Figure 5-6: Add Personnel Dialog (Marine View)
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2.

Select the type of person you wish to add from the Person Type picklist. DTAS defaults the
picklist to US Army Soldier if the Army view was selected and default to United States
Marine if the Marine view was selected. The options are DOD Contractor, DOD Federal
Civilian, Foreign National/Military, NAF Employee(AAFES), Non-DOD Federal Civilian,
Other Civilian, Red Cross Worker, United States Marine, US Air Force, US Army Soldier,
US Coast Guard, or US Navy. The fields available for data entry will vary depending on the
type of person selected. Note: Required fields are marked with an asterisk.

You may change the arrival date and time if the person’s arrival date and time differs from
the default of the system date. If you enter a date 30 days or more in the past, DTAS enables
the Re-enter Arrival Date/Time field to confirm the new arrival date and time. The date you
enter may not exceed 4 years in the past.

Enter the required information using the provided text-entry fields and picklists. Click Next

to continue with the process. DTAS displays a second Add Personnel dialog. Click Cancel
to cancel the process without saving any data.

jj Add Personnel
Help
Dty Status Agsigned
"Dty Status: |PRESEMT FOR DUTY -] “Location: | Select One -]
Feazon: | J "DateTime: | J
“DateTime: | ] Physical
Tour Status “Type: | SPECIFIC ~|
Tour Status: | Select One j Location: |F'h_l,lsical Locations ﬂ
Tour Status Subtype: |Select Ore j “Grid Zane “Grid
Designatar: Coordinates:
Tour Statuz J
Start D ate: .
“Drate,Time: | J
MHumber of
Daps:
[ Continue to Add Peaple < Back | Finizh | Cancel |

Figure 5-7: Add Personnel—Duty Status and Location Dialog (Army View)
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& Add Personnel

Help
Dty Status Agzigned
"Dty Status: |PRESEMT FOR DUTY -] “Location: | Select One |
Reason: | J “Date/Time: | J
"DatedTime: | J Physical
Tour Status *Type: | SPECIFIC ~|
Tour Status:] Select One j Location: |F'h_l,lsical Locations ﬂ
Tour Status Subtype: |Select Ore j “Grid Zane “Grid
Designatar: Coordinates:
Tour Status J
Start D ate: .
“Drate,Time: | J
Mumber of
Daps:
[ Continue to Add Peaple < Back | Finizh | Cancel |

Figure 5-8: Add Personnel—Duty Status and Location Dialog (Marine View)

5. Inthe Duty Status section, select the duty status that applies to the individual from the Duty
Status picklist. The default is Present for Duty. Depending on the duty status selected, you
may need to select a reason from the Reason picklist.

6. The date and time in the Date/Time field within the Duty Status, Assigned, Physical, and
Tour Status sections will be the date previously entered into DTAS; the field will read-only
in these data entry sections.

7. Inthe Assigned section, select a location from the Location picklist. Note: The location
selected cannot be Unknown. DTAS populates the Grid Zone Designator and Grid Zone
Coordinates based on the location selected.

8. Inthe Tour Status section, entry of this information is optional. However, if one field is
selected for entry, all fields in the Tour Status section must be entered.

9. Select a tour status from the Tour Status picklist.

10. Select a subtype from the Tour Status Subtype picklist. The values available in this picklist
are filtered depending on the Tour Status selection.

11. Enter the length of the tour in the Number of Days field. Note: The value entered must be at
least 1 and cannot be zero.

12. In the Physical section, select the type of location from the Type picklist.

13. Select a location from the Location picklist. DTAS defaults this to the Assigned location you
selected in the Assigned data entry area. The Assigned and Physical locations can be
different.

14. You may edit the Grid Zone Designator (this must be two letters) and the Grid Zone
Coordinates (this must consist of six or eight numbers). These fields are populated with the
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designator and coordinates for the Assigned location value if the Assigned and Physical
locations are the same. If the Assigned and Physical location differ, DTAS populates the
Grid Zone Designator and Grid Zone Coordinates with the values associated with the
Physical location.

15. Click Finish to save the record. DTAS returns you to the People tab. If you checked the
Continue to Add People checkbox, DTAS returns you the first page of the Add Personnel
wizard. When you have finished adding all the individuals you want, uncheck the Continue
to Add People checkbox. DTAS returns you to the People tab.

16. In addition, you may either click Back to return to the previous dialog or click Cancel to
cancel the process without saving data.

5.3.1

Add Personnel Dialog Fields

The Add Personnel dialog contains the following fields:

Person Type—This defaults to US Army Soldier if the view selected is Army. If the
view selected was Marine, the field defaults to United States Marine.

SSN/GUID (Social Security Number/Global Unique Identifier)—When entering a
Social Security number, you must enter a nine digit number or an alphanumeric character
string for a Foreign National/Military person type.

Birth Date—This defaults to the current date. You may enter the correct date by either
using the calendar function or manually typing the data.

Sex—T he default is Select One; choose either Male or Female from the picklist.

Last Name

First Name

Middle Name

Deployed UIC—This is the UIC to which this individual is deployed.

Arrival Date/Time—This is the date and time at which the individual arrived to the unit.
You may enter the correct date by either using the calendar function or manually typing
the data.

Re-enter Arrival Date/Time—This field is enabled if you enter an arrival date and time
that is 30 days or more in the past. You will be required to re-enter the date and time to
confirm that it is a valid entry. Note: You cannot enter a date that is more than 4 years
in the past.

DoD Component—The defaults for this field are as follows:

— To Army for the US Army Soldier Person Type

— To Marine Corps for the United States Marine Person Type

— To Air Force for the US Air Force Person Type

— To Coast Guard for the US Coast Guard Person Type

— To Navy for the US Navy Person Type

Military Service Component—This defaults to Regular.

MOS/AOC (Army view) or PMOS (Marine view)

Rank—This defaults to Select One.

Operation—This is a required field. The available selections are managed and sent
down from Theater Manager.
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Note:

5.4

Pay Plan—T his defaults to Select One.
Series—This defaults to Select One.

Pay Grade—This defaults to Select One.
Employer—T his defaults to Select One.
Foreign Country—This defaults to Select One.

Some of these fields are disabled (grayed out) depending on the Person Type selected.

Update Personnel

The Update Personnel function allows you to change information on DTAS for a selected
individual. This function allows you to update the person’s DoD Component, gender, the
spelling of his or her name, etc. To update personnel information for an individual, perform the
following steps:

1. Highlight the name of the individual for whom you wish to update information.

2. Click the Update Personnel button. DTAS displays the Update Personnel dialog box. Note:
The title bar of the dialog box will display the function, Update Personnel, and the name of
the person whose information you are updating.

j'j Update Personnel - PFC AHERN, COLIN
Help

*Person Type:
ssweun:[ Birth Date:|[ 1 20o0e 7 Sec[uae ]
“Last Name: “FirstName:[COL Middle Name: [DANIEL
“Deployed UIC:| B [N ]
Initial Aetival [50050913 16:46:54 GMT5:00 = |
“DoD Component[ARMY =] Military Service[ReserveE x| moswocfiF
Rank: “Operation: | Default Operation |
Pay Plan: | J
Series | =l
Pay Grade: | J Employer: | J
Faoreign Country: | J ™

ok | Cancel |

Figure 5-9: Update Personnel Dialog (Army View)
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1! Update Personnel - BYRON, GORDON

Help

BRI | IMITED STATES MAR
senUD: “Bith Date:[13200115 =] Gew [MALE |
“Last Name: [BYRON *First Mame: W Middle: M ame: ’7
“Deployed UIC: | =l Dat;ﬁ[ i”nf.?:'l E4|
Iniel Autival[20050915 17.0310 GMT5:00 ~ |
“DioD Companent: IW xMililt:aéfngg\gﬁﬁ lm‘ Pos]
Rank:|Select One hd “Dperation:|DefaultDperation j
Pay Plan: | J
Seres: | J
Pay Grade: | J Employer: | J
Fareign Country: | J B
oK | Cancel |

Figure 5-10: Update Personnel Dialog (Marine View)

3. Change the information that you need directly in each field. For example, to change the
person type, select from the Person Type picklist or to change the spelling of the last name,
type in your correction.

4. After you have completed your changes, click OK to save the changes. DTAS returns you to
the People tab screen. Click Cancel to exit the transaction without saving any changes.

Updating the Person Type, Initial Arrival Date, DoD Component, Service Component, or
Operation fields generates a message to the Theater system to update the data. If you update the
Person Type, DoD Component, or Service Component fields, DTAS prevents data from being
sent from the Theater system via the mini-record to overlay the data on the Mobile system.

5.4.1

Enabled Fields for Update Personnel

Some fields are unavailable for update depending on the Person Type selected. The following
lists the fields available for update by Person Type:

e Foreign National/Military Person Type—The following business rules for Update
Personnel apply to the Foreign National/Military Person Type:

The record retains the Mini Record Indicator of “P” status; after adding the record to
the system, the indicator does not change to “U” or “D”.

The enabled fields on load are: SSN/GUID, Birth Date, Sex, Last Name, First Name,
Middle Name, Initial Arrival Date/Time, Operation, Foreign Country and Foreign
Military.

Note: The Person Type cannot be changed.
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5.5

All Other Person Types With Mini Record Indicator of “P” or “U”—The following
business rules for Update Personnel apply to all Person Types with a Mini Record
Indicator of “P” or “U”—except Foreign National/Military:

— All fields that are appropriate to the Person Type are enabled.
— If Person Type is changed, then fields are enabled or disabled as needed.
— Note: The Foreign National/Military will not be a value in the Person Type pick list.

All Other Person Types With Mini Record Indicator of “D”—The following business

rules for Update Personnel apply to all Person Types with a Mini Record Indicator of

LLD11:

— The Person Type, DoD Component, Operation, and Initial Arrival Date/Time fields
are always enabled.

— For all Military Person Types (Army, Marine, etc.), the Military Service Component
is always enabled.

— If the Person Type is changed, then the fields are enabled or disabled as needed. This
includes fields that had been previously disabled on the initial screen load.

— Note: Foreign National/Military is not listed as a value in the Person Type picklist.

Update Duty Status

The Update Duty Status function allows you to change the duty status for the individual and to
provide the reason and effective date for the change. To update the duty status for an individual,
perform the following steps:

1. Highlight the row containing the name of the individual you wish to update and either click

the Update Duty Status button or right click the mouse button and select Update Duty Status.
You can also select multiple individuals to update with the same duty status by highlighting
multiple rows. You may select multiple individuals by pressing Shift for consecutive rows
and Ctrl for nonconsecutive rows and clicking in the left-hand blank column. In addition,
you may select all records by pressing Ctrl+A. If you select more than one person, then the
Update Deployed Duty Status form defaults the Duty Status picklist to Select One and the
Date/Time field to the current date and time. At the Location form if you selected more than
one individual, the defaults are as follows: The Location pick list defaults to Select One,
both the Assigned and Physical Date/Time fields are the current date and time. The Type
picklist and the Grid Zone Designator and Grid Coordinates default values will vary
depending on the Duty Status selected.
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Deployed Theater Accountability Software (DTAS) |*._I|E|g|
File View Tools Help
People ] Locations ] Reports ] Management ]
Search By
; ] Displayed: 232
7 :Jnr(::;ﬁesub Last Name: S5N: Total: 732
CCDDEE COLLE
Last Name | First Name SS5N puIc Hanlvc Dut',r Statu;s Reason ﬁmmgned Locatlnn -
ACOSTA ANGELA CCODEE  SPC F'DY CAMP HENRY
i ADKISSOM  MARQUIS CCDDEE  SGT CAMP HEMRY
» AHERN | COUN | | CCDDEE __ CAMP HENRY
| ALLEN DEMNA CCDDEE  2LT CAMP HENRY
| AMOAKOH MARY CCDDEE  SPC PDY CAMP HENRY
| ANDERSONM ERIK CCDDEE W01 POY CAMP HENRY
| ANDERSON ~ MARCUS CCDDEE  SPC PDY CAMP HENRY
AMEST STEPHEN CCDDEE 1T FODY CAMP HENRY
|  APGER ROBERT CCDDEE  SGT FDY CAMP HENRY
| ARRINGTOMN LAVAR CCDDEE PDY CAMP EDS
AVERY JASON CEDEEE | SGT FOY CAMP HENRY
BaCH wILLIAM CCDDEE  MSG FOY CAMP HENRY
| BAILEY THOMAS CCDDEE kT FOY CAMP HENRY
| BANKSEVAN JASON CCDDEE | SPC FOY CAMP HENRY
BARMES DaVID CCDDEE | SPC POY CAMP HENRY
| BASMETT JARROD CCDDEE LT FOY CAMP HENRY
< | @il I »
Update Update Duty Update Update Update Tour Delete Wiew Mini-
Personnel Personnel Status Location puIC Status Person Record
AMER\z%nd [ ;-Gueued Messages: 0 Y

Figure 5-11: Display Grid—Selection Highlighted

2. DTAS displays the Update Deployed Duty Status dialog box.

Update Deployed Duty Status - PFC AHERN, COLIN
Help

i Tgs RSP RESENT FOR DUTY

Heasnn|.-- _J

“Date/Time: | 20050913 16:46:54 GMT-5:00 v |

Next » Cancel ‘

Figure 5-12: Update Deployed Duty Status Dialog
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3. Select the applicable status code from the Duty Status picklist.
4. If required, select the reason for the status (for example, Emergency Leave) from the Reason

picklist.

5. Enter the date and time in the Date/Time picklist. You can select the date from the pop-up
calendar or you can highlight the components of the date and time to change those manually
(for example, clicking on the 2004 in 20040511 allows you to enter the year).

6. Click Next. DTAS displays the Update Location dialog box. Click Cancel to cancel the

update without saving any changes.

Update Location - PFC AHERN, COLIN

Help
Assigned
il (CAMP HENRY, US -
*DataTime: |2DEE-DE'1 3 16:46:54 GMT-5:00 ﬂ
Physical
“Type: | SPECIFIC |
Location: |CAMP HENRY, US -]
“Grid Zone |32 “Grid [qqna77
Desiagnator: Z Coordinates: i

*Date/Time: | 20050913 16:46.54 GMT-5:00 v |

o]

Cancel |

Figure 5-13: Update Duty Status—Location Dialog

7. Inthe Assigned data entry area, select the individual’s assigned location from the Location

picklist.

8. Select the date and time from the Date/Time picklist. You can select the date from the pop-
up calendar or you can highlight the components of the date and time to change those
manually (for example, clicking on the 2004 in 20040511 allows you to enter the year).

9. Inthe Physical data entry area, select the type from the Type picklist.

10. Select a location from the Location picklist. DTAS defaults this to the Assigned location you
selected in the Assigned data entry area. The Assigned and Physical locations can be

different.
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11. You may edit the Grid Zone Designator (this must be two letters) and the Grid Zone
Coordinates (this must consist of six or eight numbers). These fields are populated with the
designator and coordinates for the Assigned location value if the Assigned and Physical
locations are the same. If the Assigned and Physical location differ, DTAS populates the
Grid Zone Designator and Grid Zone Coordinates with the values associated with the
Physical location.

12. Select the date and time from the Date/Time picklist. You can select the date from the pop-
up calendar or you can highlight the components of the date and time to change those
manually (for example, clicking on the 2004 in 20040511 allows you to enter the year).

13. Click OK to save the record. Click Cancel to cancel the update without saving any changes.

5.5.1

5.5.1.1

Business Rules: Update Duty Status Dialog

GENERAL BUSINESS RULES

The following business rules apply to the Update Duty Status dialog:
e The following duty statuses do not require a reason:

Confined by Military Authorities
Convalescent Leave

Death Other

Duty Status Where Abouts Unknown
Hospitalized (Battle Incurred)
Hospitalized (Nonbattle Incur)
Killed in Action

Present for Duty

Temporary Duty

Wounded in Action

e The following duty statuses require reasons (as listed):

In-Transit—Requires one of the following reasons: Convalescent Leave,
Emergency Leave, Local Reassignment, Mission Complete, Rest and Recuperation,
and Temporary Duty

Missing—Requires one of the following reasons: Absent Without Leave,
Beleaguered, Besieged, Captured, Detained, Interned, Missing, and Missing in Action

Redeployed—Requires one of the following reasons: Absent Without Leave;
Convalescent Leave; Dropped From Rolls; Emergency Leave; Erroneously Added:;
Hospitalized (Nonbattle Incur); Hospitalized (Battle Incurred); Mission Complete;
Rest and Recuperation; and Temporary Duty.

Rest and Recuperation (R&R)—Requires you to select one of the following
reasons: Leave or Pass.

e The Date/Time entered cannot be a future date or time.

e When a Date/Time is entered that is prior to the current date/time, a history record is sent
to the Theater and Enterprise systems, and the current status remains on the Mobile
system.

e When entering a Duty Status of Death Other or Killed in Action, the effective date
entered must be more recent than the current Duty Status effective date.
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e A message is sent to the Theater system.

e If you erroneously added a person to the mobile database, you may tag this person’s
record for deletion using the Update Duty Status function. Select a Duty Status of
Redeployed and then select Erroneously Added to indicate the person was added
incorrectly. DTAS deletes the record after 24 hours.

5.5.1.2 SYSTEM MESSAGES
DTAS generates several system messages depending on the duty status selected, as follows:

e DTAS displays the following message with these duty statuses: Death Other, Killed in
Action, and Wounded in Action.

Update Duty Status gj

i MOTICE: It is imperative that casualky skatus daka be kreated as
sensitive until verification of notification of Family membersfnext of kin,

Figure 5-14: System Message—Casualty Status Warning

e The Convalescent Leave duty status should only be used for in-theater convalescence.
When you select this duty status, DTAS displays a message reminding you that this code
is for in-theater convalescent leave only and that you should use the Redeployed —
Convalescent Leave for convalescence outside the theater.

Update Duty Status @

This duky status is used for In-Theater Convalescent
‘!J‘) leave anly, Faor convalescent leave outside the theater use
REDEPLOYED - COMYALESCEMT LEAYE RED-CLY,

Figure 5-15: System Message—Redeployed-Convalescent Leave
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e DTAS generates the message shown below if you select a duty status of Hospitalized
(Battle Incurred).

@ The soldier must currenth be in a WIA duty skatus,

Figure 5-16: System Message—Hospitalized (Battle Incurred)

e DTAS generates the message shown below if you select a duty status of Rest and
Recuperation (R&R).

X

Lpdate Duty Status

® . Thisis only used for Soldiers whotake RRMNR
‘!’) leave and skay in thie Deploved Theater, Use
RECEPLOYED-REST AND RECLIPERATION
[RED-RMRY For COMUS ar OCORUS,

Figure 5-17: System Message—Redeployed-Rest and Recuperation

e DTAS generates the message shown below if you select a duty status of Temporary Duty.

Update Duty Status E|

kermporary duby skakus bo support certain missions for a shaork time,
IJse REDEPLOYED-TEMPORARY DIUTY (RED-TDY) For Soldier's whio
are assigned to the Theater who depart to serve in a TDY status
outside the Deploved Theater,

j}) Ilsed For Soldier/Person's Deplowving into the Theater to serve in a

Figure 5-18: System Message—Redeployed-Temporary Duty

e Selecting a duty status of Redeployed with a reason of Hospitalized (Battle Incurred)
generates the following message:
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Update Duty Status &|

Solder/Person's current Duty Stakus must be WIA or HOW,
'1) IJse REDEPLOYED-HOSPITALIZED(BATTLE INCURRELD)

(RED-HOW if the SoldierfPerson is being Reassigned to a
rear hospital unit,

-

Figure 5-19: System Message—Redeployed-Hospitalized (Battle Incurred)

Selecting a duty status of Redeployed with a reason of Dropped from Rolls generates the
following error message if the 31-day threshold has not been met:

Update Duty Status

X

@ The soldier must currenthy be in &WOL status for at least 31 days.

Figure 5-20: System Message—Redeployed-Dropped From Rolls

Selecting a duty status of Redeployed with a reason of Temporary Duty generates the
following error message:

Lpdate Duty Status

\j‘) Ilsed For Soldiers/Person's who are assigned to the Theater who

will depart to serve in a TOY status outside the Deploved Theater,
For Soldiers/Person's deploying into the Theater ko serve in a

temporary duky status bo support certain missions For a short time
use TEMPORARY DUTY (TDY),

Figure 5-21: System Message—Temporary Duty

Selecting a duty status of Redeployed with a reason of Erroneously Added generates the
following error message:
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5.5.2

Update Duty Status

This action will delete the person record from
the mobile system and Theater system,

Figure 5-22: System Message—Erroneously Added
Selecting a Duty Status of Death Other or Killed in Action and entered a date later than
the current Duty Status effective date generates the following message:
Update Duty Status @

i Cannot enter historical information for KIA or DO duty status for
Mo database update performed.

Figure 5-23: System Message—Killed in Action/Death Other

Business Rules: Update Duty Status, Update Location Dialog
The Grid Zone Designator must be two alphanumeric characters.
The Grid Coordinates must be six or eight numbers.
The Assigned Date/Time cannot be a future date and time.
The Physical Date/Time cannot be a future Date/Time.

When a Date/Time is entered that is prior to the current date/time, a history record is sent
to the Theater and Enterprise systems, and the current status remains on the Mobile
system.

If you perform an update on multiple people (by using multi-select), the Assigned
Location section can be left blank. If an Assigned location is not entered, only the
Physical location will be updated for each person selected.

The following duty statuses will have Unknown as the default Type in the Physical data
entry area: Missing (all reasons) and Duty Status Where Abouts Unknown.

The following duty statuses will have In-Theater as the Type selection in the Physical
data entry area: Convalescent Leave and Rest and Recuperation (R&R).

The following duty statuses will have Specific as the default Type in the Physical data
entry area:
— Confined by Military Authorities

— Hospitalized (Battle Incurred)*
— Hospitalized (Nonbattle Incur)
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5.6

In-Transit (with the following reasons: Convalescent Leave, Emergency Leave,
Mission Complete, Rest and Recuperation, and Temporary Duty)

Killed in Action

Present for Duty

Redeployed (Drop from Rolls)

Temporary Duty

Wounded in Action

*Note: The individual must first be in Wounded in Action status.

If you select In Transit with a reason of Local Reassignment, the Next button is an OK
button. Click OK and DTAS updates the status and returns you to the People tab.

The Physical location information for the Redeployed duty status varies by reason code,
as follows:

The Absent Without Leave and Dropped from Rolls reason codes will have a location
of Unknown.

The Convalescent Leave, Emergency Leave, Hospitalized (Nonbattle Incur),
Hospitalized (Battle Incurred), Mission Complete, Rest and Recuperation, and
Temporary Duty reason codes will have location selections of OCONUS and
CONUS.

A message is sent to the Theater system.

Update Location

The Update Location function allows you to update the assigned and physical locations for a
selected person. To update the location for the selected individual, perform the following steps:

1. Highlight the record of the individual you wish to update and click the Update Location

button. DTAS displays the Update Location dialog. You may select multiple individuals by
pressing Shift for consecutive rows and Ctrl for nonconsecutive rows and clicking in the
left-hand blank column. In addition, you may select all records by pressing Ctrl+A. If you
select more than one person, then the Update Location form defaults the Location pick list to
Select One and both the Assigned and Physical Date/Time fields to the current date and time;
the Grid Zone Designator and Grid Coordinates are blank.
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Update Location - PFC AHERN, COLIN
Help

Assigned

il (CAMP HEMRY, US -

*Date/Time: | 20050912 16:46.54 GMT-500 |

Physical

*Type: | SPECIFIC |

Location: |CAMP HENRY, LS -]
*Grid Zone T “Grid —
Designator: = Coordinates: i

*Date/Time: | 20050912 16:46.54 GMT-5:00 v |

oK |  Cancel |

Figure 5-24: Update Location Dialog

. Within the Assigned data entry section, select a location from the Location picklist. DTAS
populates the Grid Zone Designator and Grid Coordinates fields based on the selected
assigned location.

Select the date and time from the Date/Time picklist. You can select the date from the pop-
up calendar or you can highlight the components of the date and time to change those
manually (for example, clicking on the 2004 in 20040511 allows you to enter the year).

. Within the Physical data entry section, you may select the location type from the Type
picklist.

Select a location from the Location picklist. DTAS defaults this to the Assigned location you
selected in the Assigned data entry area. The Assigned and Physical locations can be
different.

You may edit the Grid Zone Designator (this must be two letters) and the Grid Zone
Coordinates (this must consist of six or eight numbers). These fields are populated with the
designator and coordinates for the Assigned location value if the Assigned and Physical
locations are the same. If the Assigned and Physical location differ, DTAS populates the
Grid Zone Designator and Grid Zone Coordinates with the values associated with the
Physical location.
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7. Select the date and time from the Date/Time picklist. You can select the date from the pop-
up calendar or you can highlight the components of the date and time to change those
manually (for example, clicking on the 2004 in 20040511 allows you to enter the year).

8. Click OK to save the data. DTAS returns you to the People tab. Click Cancel to cancel the
transaction without saving any data.

5.7 Update DUIC
The Update Deployed UIC function allows you to change the DUIC for a selected individual.

Note: The Update DUIC function is available only for those individuals for whom you have
direct control. (It is not available for those individuals one or more active levels below yours.)

To update the DUIC for an individual, perform the following steps:

1. Highlight the name of the individual for whom you wish to update the DUIC. To select a
record, highlight the row in the display that lists the soldier you wish to select. You may
select multiple individuals by pressing Shift for consecutive rows and Ctrl for
nonconsecutive rows and clicking in the left-hand blank column. In addition, you may select
all records by pressing Ctrl+A. If you do select more than one individual, the Current
Deployed UIC field will be blank and the New Deployed UIC picklist will default to Select
One.

2. Click the Update DUIC button. DTAS displays the Update DUIC dialog box. Note: The
title bar of the dialog box will show the name of the function, Update DUIC, and the name of
the individual whose record you are updating.

Update DUIC - PFC AHERN, COLIN
Help

Current Deployed UIC: [CCODEE
g EORR L W (el CCODEE COLLEEN TEST -

0K | Cancel |

Figure 5-25: Update DUIC Dialog

3. Select the new DUIC from the New Deployed UIC picklist.

4. Click OK to save the change. DTAS returns you to the People tab screen. Click Cancel to
exit the action without saving any changes.

5.8 Update Tour Status

The Update Tour Status function allows you to update the Tour Status type, Tour Status subtype,
date and time of the tour, and the length of the tour for a selected soldier or selected soldiers.
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To update the status of an individual, perform the following steps:

5.

Highlight the name of the individual whose tour status you wish to update. Note: You may
select multiple individuals by pressing Shift for consecutive rows and Ctrl for
nonconsecutive rows and clicking in the left-hand blank column. In addition, you may select
all records by pressing Ctrl+A.

Click the Update Tour Status button. DTAS displays the Update Tour Status dialog. Note:
The title bar of the dialog box will show the name of the function, Update Tour Status, and
the name of the individual whose record you are updating.

Update Tour S5tatus - SGT ADKISSON, MARQLIIS

Help
*Taur Status: |EEE= S
*Tour Statuz Subtype: | Select One j
*DatesTirme: |2EIEIEEIE|1E| 12:35:51 GMT ﬂ
*Murnber of
Days:
Ok, | Cancel |

Figure 5-26: Update Tour Status

Select a tour status from the Tour Status picklist. The available options are Permanent Party,
Temporary Change of Station, or Temporary Duty.

Select a subtype from the Tour Status Subtype picklist. The available options are filtered
depending on the Tour Status selected. Refer to Section 5.8.1, Tour Status/Tour Status
Subtype Combinations, for a list of the subtypes available for the Tour Status selected.

Select the date and time from the Date/Time picklist. You can select the date from the pop-
up calendar or you can highlight the components of the date and time to change those
manually (for example, clicking on the 2004 in 20040511 allows you to enter the year). You
can enter a date prior to the identified Theater Arrival Date/Time. If you do so, DTAS
displays a message (shown below) stating you have entered a date the precedes the Theater
Arrival Date/Time and that the Date/Time may be changed to match the Theater Arrival
Date/Time on the Enterprise system. Note: You cannot enter a Date/Time that is in the
future.
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Update Tour Status @

i Tour Status updated is prior bo Theater arrival For
Message will be sent to Theater, but date mayv be changed.

Figure 5-27: Update Tour Status Message

Note: The Update Tour Status message contains the Social Security number of the
individual you are updating; however, it has been removed in this example for privacy
reasons.

10. Enter a value for the length of the tour in the Number of Days field. Note: The value must
be a number greater than zero.

11. Click OK to save your changes. DTAS returns you to the display grid.

5.8.1 Tour Status/Tour Status Subtype Combinations

The following Tour Status Subtypes are available when you select a Tour Status of Permanent
Party:

e Individual — Augmentee
¢ Individual — Replacement
e Unit — Active

The following Tour Status Subtypes are available when you select a Tour Status of Temporary
Change of Station:

¢ Individual — Augmentee

e Individual — Individual Ready Reserve (IRR)

¢ Individual — Replacement

e Individual — Retiree Recall

e Unit — Active

e Unit — Active Guard Reserve (AGR)

e Unit — Individual Mobilized Augmentee (IMA)
e Unit — Individual Ready Reserve (IRR)

e Unit — Retiree Recall

e Unit — Troop Program Unit (TPU)
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The following Tour Status Subtypes are available when you select a Tour Status of Temporary
Duty:

¢ Individual — Augmentee

e Unit — Active

e Unit — Active Guard Reserve (AGR)

e Unit — Troop Program Unit (TPU)

¢ Individual — Active Guard Reserve (AGR)
e Individual — Troop Program Unit (TPU)

5.9 Delete Person

The Delete Person function allows you to delete a DTAS personnel record for a person who was
incorrectly added to the system and whose record has not been sent to the Theater system. The
Delete Person function should not be used for an individual who is leaving the theater, who
should be assigned a duty status of Redeployed—Mission Complete using the Update Duty Status
function. To delete the record for an individual, perform the following steps:

1. Highlight the name of the individual whose record you wish to delete. Note: You cannot
delete an individual whose mini-record has been downloaded. For an individual whose mini-
record has been downloaded, use the Update Duty Status function and assign the person a
duty status of Redeployed—-Erroneously Added to remove them and delete their record on the
Theater database. Assigning an individual a deployed duty status of Redeployed when they
leave the theater deletes that individual from your mobile system. DTAS displays the
following message if you select an individual whose mini-record has been downloaded.

Delete Person g|

\E) Cannot delete personnel record if mini record has already been downloaded,

Figure 5-28: Delete Person—Error Message

2. Click the Delete Person button. DTAS displays the Delete Person confirmation.

Delete Person

Are wau sure you wank ko permanently delete this record?

Ik | Cancel J

Figure 5-29: Delete Person—Confirmation Message
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3. Click OK to confirm that you wish to delete this record. DTAS deletes the record and returns
you to the People tab screen.

4. Click Cancel to cancel deletion of the record. DTAS returns you to the People tab screen,
and the record remains in the database.

5.10 View Mini-Record

The View Mini-Record function provides an abbreviated personnel record for the selected
individual. For ease of use, the record is divided into five tabs: Deployment, Basic, Service,
Personal, and Patient Tracking.

The data displayed in the mini-record is downloaded to the Mobile database from the Enterprise
System, which receives the data from eMILPO and ODSE for Army and Marine Corps
personnel, respectively. If a person is not on either eMILPO or ODSE, then the data is obtained
from DMDC. Please contact the Theater Manager if these records do not download properly
(remain in P status).

To view the mini record, perform the following steps:
1. Highlight the name of the person for whom you wish to review the record.

2. Click the View Mini-Record button. DTAS displays the DTAS Mini-Record Screen with the
Deployment tab as the default view.

3. To view another tab, click on that tab.
4. Click Close to return to the People tab.

5.10.1 Deployment Tab

The Deployment tab displays information about an individual’s deployment, such as Deployed
Operation Name, Tour Status information, and location information.
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~#] DTAS Mini Record - PFC AHERN, COLIN

Help

Deployment Information

Deplayment ] Service] Baszic l F'ersonall Patient Tracking

puIC: {CCODEE

Current Unit &mival [Sn0e0971 3
Drate:

Perzonnel Type: |U5 ARMY SOLDIER Limited Esternal Data Block: lN

DUIC Urit Marme: [COLLEEM TEST

20050913

Individuals Physical (33398877 - CaMP HENRY, US
Location:

Urit Location: [CAMP HENRY, US Dieploved Countn: |UNITED STATES

Deplayed Operation |Default Operation
Marme:

Deploved Cuty Status:|POY Reasar:

Taur Statuz Start
e 20050913

Tour Status
Subtype:

usﬂ|57

Tour StatusType: |Permanent Party

|Individual - Augmentes

Tour Statuz End{50050913
Crate:

Figure 5-30: Deployment Tab (Army View)

DTAS Mini Record - BYRON, GORDON
Help

Deployment Information

Deployment ] Sewice] Bazic ] F'ersonall Patient Tracking

DUIC: |CCODEE

Current Uit Armival (20050915
Date:

Personnel Type: |UN|TED STATES MARINE Limited External D ata Block: IN

DUIC Urit Mame: |[COLLEEN TEST

20050915

Individuals Physical |A1 070476 - CAMP EDS AF
Location: ‘

Uit Location: |E-‘5-MP EDS. AF Deployed Country: |AFGHAMISTAN

Deployed Operation |Default Operation
Mame:

Deployed Duty Status: PO Fieasot

Tour Status Start
o 20050915

Tour StatusType: |Ternp-:rary Change of Station Tour Status

Tour Status #4127
Davs:

|Unit - Active Guard Reserve [AGR)

Tour Status End 20050113
Drate:

Figure 5-31: Deployment Tab (Marine View)
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5.10.2 Service Tab

The Service tab displays military service-related information, including the service component,

home UIC, and BASD.

| DTAS Mini Record - PFC AHERN, COLIN

Help
Deplayment  Service l Basic ] Personal] PatientTracking]

Service Information

DaD Service

AED)

Drate of
Ao 20030428

DEROS:

ETs:[20030730 BA5D: 20020620

PEED: | 20020403

Component: [&FRMY Service Component:|RESERVE
Home LI C; [Wilatbib, Home Unit Mame: |
MPLC: ’E_ Military E ducation Lewel: |NOME

Claze

Figure 5-32: Mini-Record—Service Tab (Army View)

X DTAS MiniRecord - BYRON, GORDON

Help
Deployment  Service ] Basic ] Pelsonal] PatientTlacking]

Service Information

Dol Service
Compotent: [MARINE CORPS Service Component: | REGULAR
Fresent RUC: Pres RUC Unit M ame; |
Officer/Enlisted: ’_ Military Education Level:
Botc DEROS:
Rank:
AFADE: E&S:
FEBD:

Cloze

Figure 5-33: Mini-Record—Service

Tab (Marine View)
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5.10.3 Basic Tab

The Basic tab displays information, such as the individual’s name, Social Security Number,

Rank, etc.

-] DTAS Mini Record - PFC AHERN, COLIN

Help

Deployment] Service Basic ]Pelsonal] PatientTlacking]

Biazic Information

Last Mame: |AHERM

SSN/GUID: |

Pay Plar:

E mployer Mame; |

Rank: [FFC

Senes:

First Mame: |COLIN

Pay Grade:

Middle Mame: |DANIEL

Secuiity Clearance: |

Securty Clearance D ate:
Mos: |32F SMOS: Skill Level: |1_
AMOS: Tstbb0S: MAGTF:

oo MOME
Sal Al Language:

OFID:

Cloze

Figure 5-34: Mini-Record—Basic Tab (Army View)

A DTAS Mini Record - BYRON, GORDON

Help
Deplo_l,lment] Service Basic lPersonaI] PatientTracking]

B agic Information

Last Narne: |BYROM

S5N/GUID: |

Fay Plan:

Employer Mame: |

Fank: |

Series:

First Narne; |GORDOM

Pay Grade:

Middle Marne:

Secunty Clearance: |

Secunty Clearance Date:
PMOS: SMOS: Skil Level:|_
AMOS: 1st AMOS: MAGTF:

Language:“

OFID:

Cloze

Figure 5-35: Mini-Record—Basic Tab (Marine View)
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5.10.4 Personal Tab
The Personal tab displays information such as birth date, race, and blood type.

j_]' DTAS Mini Record - PFC AHERN, COLIN
Help

Deployment] Service] Basic  Personal 1PatientTracking

Personal Infarmation

Birth Diate: |135340814 4 arital Status: ’S_ Fieligious Denom; [UMNITH UMIY ASH

Country of | I
Citizenship: li Flace_lc_ Sex ’M_
Citizenship
Drieir Ethnic Group: [DTHER
HOR State: HOR: Ciy: |
Blood Type:

Cloze

Figure 5-36: Mini-Record—Personal Tab (Army View)

%' DTAS Mini Record - BYRON, GORDON
Help

Deployment] Sewice] Easic  Fersonal 1 PatientTlacking]

Personal Information

Birth Date; | 13200915 b arital Status: ’_ Religious D enom:

Country of ! L
Citizenship: Race: j_ Sex IM_
Citizenship
Crrigir: Ethinic Group:
HOR State: HOR City: |
Blood Type:

Cloge

Figure 5-37: Mini-Record—Personal Tab (Marine View)
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5.10.5 Patient Tracking Tab

The Patient Tracking tab allows you to view hospitalization and condition information for a

selected person.

j]l DTAS Mini Record - PFC AHERN, COLIN
Help

Deplo_l,lment] Sewice] Basic ] Perzonal  Patient Tracking l

Fatient Tracking Infarmation

Admiszion Date:

Hozpital |
Description:

Dizcharge Date:

Diestination |
Desorption:

Condition Description: |

Statug Diegcription:

Patient Dispostion: |

Remarks:

Cloze

Figure 5-38: Mini-Record—Patient Tracking (Army View)

1‘ DTAS Mini Record - BYRON, GORDON
Help

Deploymenl] Service] Bazic ] Perzonal  Patient Tracking ]

Patient Tracking [nformation

Admizzion D ate:

Hozpital |
Description:

Dizcharge Date:

Destination |
Description:

Condition Description: |

Statuz Description:

Patient Dizpostion: |

Remarks:

Close

Figure 5-39: Mini-Record—Patient Tracking (Marine View)
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6. LOCATIONS TAB

The Locations tab displays data related to locations within the deployment theater. Locations are
managed—including adding and editing locations—Dby the Theater Manager.

Deployed Theater Accountability Software (DTAS)

File View Toolz Help

People Locations | Reports I Management I

Location Name | Country | City | Coordinates

4 CAMP GRANADA ALASKA 123456
CAMP JERSEY ARUBA BALTIMORE 11111111

CAMP EDS AFGHANISTAN 070476
CAMP SQTUAT ALASKA Lasfessd

CAMP HENRY UMITED STATES LEWISBURG 993877

CAMP FASADENA BARBADOS GOTHOM 121212
CAMP PENN STATE ST LUCIA STATE COLLEGE 10000000

CAMP SUSAN G UMITED STATES ASHEURHN 223332

AMERz%nd lé |5yﬂd1mnjzaﬁon Complete - 9/29/2008 3:37:17 PM i(]ueued Messages: 0

Figure 6-1: Locations Tab
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7.

REPORTS TAB

The Reports tab displays the available reports that you may generate within the DTAS
application. The Reports function allows you to generate several reports to assist in tracking
deployed personnel. You can generate the following four reports:

Gains/Losses Report—The report displays those personnel who have either arrived
at the DUIC or become a non-asset to the organization during the 12-hour reporting
period. The report presents data from the 12-hour period preceding the time you
generate the report. The report consists of two parts—Gains and Losses—that are
each presented on a separate worksheet in Microsoft Excel.

In Transit Report—This report displays data on those personnel who are in transit
from the DUIC.

PERSTAT Report—This is the DTAS Personnel Status Report. The report consists
of four parts: Personnel Daily Summary, Loss Summary, Gains Summary, and
Remarks. The Remarks field is editable by the user; DTAS populates the other
columns with data from the database.

Unit Roster—The Unit Roster lists all deployed personnel assigned to the unit for
which you generate the report.

DTAS displays all reports in Microsoft Excel. You can only produce reports for the UICs for
which you have visibility. You have the capability to generate all available reports for your
UICs. You can manipulate the reports in Excel. For directions on generating a report, refer to
Section 7.1, Generating a Report.
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Deployed Theater Accountability Software (DTAS)
File View Tools Help

F‘eople] Locations Feports l Management l

Select UIC: | Select One =
&
a3
r
'l
r
Sart By: J

Yiew Report

AMERz%nd =2 |Synchronization Complete - 9/23/2005 3:37:17 PM Cueued Messages: 0

Figure 7-1: Reports Tab

71 Generating a Report

To generate a report, perform the following steps:

1. Select a UIC from the Select UIC picklist.

2. Check the Include Sub Unit checkbox if you would like to include personnel data from

“child” UICs; otherwise, the report will include only personnel data related to the selected
UIC.

3. Click the radio button to the left of the report you wish to generate.

4. If you selected the Unit Roster report, the Sort by picklist is activated. Select a criterion by
which you would like to sort the report data. You can only select one criterion.

5. Click View Report to generate the report. DTAS displays the report in Microsoft Excel.

6. You can print or save the report from within Excel. To print the report, select Print from the

File menu and click OK. To save the report, select Save from the File menu, assign a file
name, and click Save.

7.2 Gains/Losses Report

The Gains/Losses Report is divided into two worksheets: one for gains and one for losses. The
Gains portion of the report lists personnel who have arrived in the current 12-hour reporting
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period as a gain to the DUIC. This is determined by the person’s arrival date and arrival time to
the DUIC. The Losses portion of the report lists those personnel who are no longer an asset to
this organization. These personnel became a non-asset during the current reporting period.

7.21 Data Definitions (Army View)

The following are the definitions for the data columns contained on both the Gains worksheet
and the Losses worksheet of the Army report:

e DUIC—This is the deployed unit identification code of the unit. This number is only
displayed when this report is run at the unit level.

e Unit Name—This is the corresponding unit name of the DUIC.

e DTG—Date Time Group prepared. The DTG will be in the following format:
221805ZNOV04. The following is an explanation of this format:

— 22is the day of the month
— 1805 is the military time

— Zrepresents Zulu

— NOV represents November
— 04 represents the year

e Name—This is the name of the individual gain or loss during this reporting period.

e SSN/GUID—This is the Social Security number or global unique identifier (GUID)
of the individual gain or loss during this reporting period.

e Person Type—This is the Person Type of the individual gain or loss during this
reporting period. Person Types can be one of the following: DOD Contractor, DOD
Federal Civilian, Foreign National/Military, NAF Employee(AAFES), Non-DOD
Federal Civilian, Other Civilian, Red Cross Worker, or United States Marine, US Air
Force, US Army Soldier, US Coast Guard, or US Navy.

e DoD Component—This may contain one of the Department of Defense Component
codes.

e Service Component—This is the Service Component of the individual gain or loss
during this reporting period. The Service Component may be one of the following:
National Guard, Regular, Reserve, or Unknown.

e Rank—This is the rank of the individual gain or loss.

e PMOS/AOC/Series—This is the primary MOS/AQOC/Series of the individual gain or
loss during this reporting period.

e SQI—This is a list of all Skill Qualification Identifiers (SQIs) of the individual gain
or loss during this reporting period.

e ASI—This is a list of all Additional Skill Identifiers (ASIs) of the individual gain or
loss during this reporting period.

e 2" MOS—This is the secondary MOS of the individual gain or loss during this
reporting period.

e LANG—THhis is list of all language identifiers of the individual gain or loss during
this reporting period.

e Sex—This is the sex of the individual gain or loss during this reporting period.
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e DDS—This is the deployed duty status of the individual gain or loss during this
reporting period.

¢ DDS Reason—This is the deployed duty status reason code of the individual in
transit.

e DDS Date—This is the deployed duty status date of the individual gain or loss during
this reporting period.

e Theater Arrival Date—This is the initial arrival date to the theater for the current
deployment.

e DUIC—This is the deployed unit identification code of the unit. This column is only
necessary if this report is run at a level that is higher than the unit level.

7.2.2 Gains/Losses Report Sample (Army View)

DTAS displays the Gains/Losses Report for the Army view in an Excel spreadsheet template as
shown in the samples below.

SECRET

DTAS GAINS / LOSSES REPORT

DUk UNIT HARE OTG
CCODEE COLLEEM TEST
*GAINS:

GakE WD 35 of the 12 WOV T POt perksl.
Dep ke Dty Stats

: S THEATER
E cen o | PERSEN 05D L
" = TVPE |CoMPONENT|Compo HENT[™

PROST = : i
ADTY =] Al ,].!.E L& NG [SEx | DDS™ ngfl_lu %E;E ARRIVAL | DUIC
SERIES P HE e [ DATE

SECRET

Figure 7-2: Gains Worksheet (Army View)

Draft November 14, 2005
7-4
FOR OFFICIAL USE ONLY



DTAS Mobile Application User Manual CM No. DTAS-MAUMO0-010-20051114

SECRET
DTAS GAINS /LOSSES REPORT
TIE THIT HEME 76
oCDDEE COLLEEN TEST
*LO55ES:
“Loszes willbe a3 ottie 12 howr e po g pe oo,
~Dep byedl Dty Statis
THEATER
: e PEFSON|  DoD SERVICE PSS 860 | . A o, .| best [opse[TMENT %
HAME SFMIGUD repe |companent|[component| PN zeRiEs =i Al mas | HHG 5B O0S prason | nare | ATRIAL) DUE
SECRET

Figure 7-3: Losses Worksheet (Army View)

7.2.3 Data Definitions (Marine View)
The following are the definitions for the data columns contained on the both the Gains worksheet
and the Losses worksheet of the Marine view report:

e DUIC—This is the deployed unit identification code of the unit. This number is only
displayed when this report is run at the unit level.

e Unit Name—This is the corresponding unit name of the DUIC.

e DTG—Date Time Group prepared. The DTG will be in the following format:
221805ZNOV04. The following is an explanation of this format: 221805ZNOV04

— 22is the day of the month
— 1805 is the military time

— Zrepresents Zulu

— NOV represents November
— 04 represents the year

e Name—This is the name of the individual gain or loss during this reporting period.
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SSN/GUID—This is the Social Security number or global unique identifier (GUID)
of the individual gain or loss during this reporting period.

Person Type—This is the Person Type of the individual gain or loss during this
reporting period. Person Types can be one of the following: DOD Contractor, DOD
Federal Civilian, Foreign National/Military, NAF Employee(AAFES), Non-DOD
Federal Civilian, Other Civilian, Red Cross Worker, or United States Marine, US Air
Force, US Army Soldier, US Coast Guard, or US Navy.

DoD Component—This may contain one of the Department of Defense Component
codes.

Service Component—This is the Service Component of the individual gain or loss
during this reporting period. The Service Component may be one of the following:
National Guard, Regular, Reserve, or Unknown.

Rank—This is the rank of the individual gain or loss.

PMOS—This is the Primary Military Occupational Specialty of the individual gain
or loss during this reporting period.

AMOS—This is the Alternate Military Occupational Specialty of the individual gain
or loss during this reporting period.

1** AMOS—This is the First Alternate Military Occupational Specialty of the
individual gain or loss during this reporting period.

LANG—This is list of all language identifiers of the individual gain or loss during
this reporting period.

Sex—T his is the sex of the individual gain or loss during this reporting period.

DDS—This is the deployed duty status of the individual gain or loss during this
reporting period.

DDS Reason—This is the deployed duty status reason code of the individual in
transit.

DDS Date—This is the deployed duty status date of the individual gain or loss during
this reporting period.

Theater Arrival Date—This is the initial arrival date to the theater for the current
deployment.

DUIC—This is the deployed unit identification code of the unit. This column is only
necessary if this report is run at a level that is higher than the unit level.
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7.24 Gains/Losses Report Sample (Marine View)

DTAS displays the Gains/Losses Report for the Marine view in an Excel spreadsheet template as
shown in the samples below.

SECEET

DTAS GAINS | LOSSES REPORT

TUIC UHIT NAME LT
CCDDEE COLLEEN TEST
"GAINS:

®izairs will be a5 of the 12 hour reporting period.
“heployved Dby Status

FERSON Lol SERWICE 1st
HENE EENEEUID TYFE | COMPOMENT | CORPOMENT PN EMOSHEIS

THEATER
~| DDE |DDE™
AMOS LAM G | SEX | DDE REASON | DATE ARRMAL [ DUIC

LATE

SECEET

Figure 7-4: Gains Worksheet (Marine View)
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SECRET
DTAS GAINS | LOSSES REPORT
ouic LINIT HAME DTG
CCODEE COLLEEM TEST
‘LOSSES:
"lozges will be az afthe 12 hour reporting period.
“Deployed Doty Status
HahE SEN S GUID RERSEN Db, SERMICE Rt WK | PRACIS | AIDS =t LAHG | SEX | DDS™ DDSE:, [DEe LHRERAI\IEE Ui
TvPE | COMPOMENT | COMPOMENT AnOES REASOM | DATE DATE
SECRET
Figure 7-5: Losses Worksheet (Marine View)
7.3 In Transit Report
7.31 Data Definitions (Army View)

The following are the definitions for the data columns contained on the In Transit report for the
Army view:

DUIC—This is the deployed unit identification code of the unit. This block is only
displayed when this report is run at the unit level.

Unit Name—This is the corresponding unit name of the DUIC.

DTG—Date Time Group prepared. The DTG will be in the following format:
221805ZNOV04. The following is an explanation of this format:

— 22is the day of the month
— 1805 is the military time

— Zrepresents Zulu

— NOV represents November
— 04 represents the year
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Name—This is the name of the individual gain or loss during this reporting period.

SSN/GUID—This is the Social Security number or global unique identifier (GUID)
of the individual in transit.

Person Type—This is the Person Type of the individual gain or loss during this
reporting period. Person Types can be one of the following: DOD Contractor, DOD
Federal Civilian, Foreign National/Military, NAF Employee(AAFES), Non-DOD
Federal Civilian, Other Civilian, Red Cross Worker, or United States Marine, US Air
Force, US Army Soldier, US Coast Guard, or US Navy.

DoD Component—This may contain one of the Department of Defense Component
codes.

Service Component—This is the Service Component of the individual gain or loss
during this reporting period. The Service Component may be one of the following:
National Guard, Regular, Reserve, or Unknown.

Rank—This is the rank of the individual in transit.

MOS/AOC/Series—This is the MOS/AOC/Series of the individual in transit.
DDS—This is the deployed duty status of the individual in transit.

DDS Date—This is the deployed duty status date of the individual in transit.

DDS Reason—This is the deployed duty status reason code of the individual in
transit.

Theater Arrival Date—This is the initial arrival date to the theater for the current
deployment of the individual in transit.

Phys. Loc.—This is the physical location of the individual in transit.

Location Arrival Date—This is the arrival date to the current location of the
individual in transit.

DUIC—This is the deployed unit identification code of the unit. This column is only
necessary if this report is run at a level that is higher than the unit level.
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7.3.2 In-Transit Report Sample (Army View)
DTAS displays the In-Transit Report in an Excel spreadsheet template as shown in the Army
view sample below.

SECRET
DTAS IN-TRANSIT REPORT
B JOTT MAME BTG
CCDDEE | COLLEEN TEST 2114537 5EP DS
FDeploved Duty Stdus
THEATER TOCATION
FERSON DD SERICE MOS BOCS DDst| DS PHYS
MAME | SENSGUID | pype | componenT |componenT B seriEs |PUE | pate |REASON [ “RRIVAL L o | ARRIVAL JDUIC
DATE DATE
SECRET

Figure 7-6: In-Transit Report Sample (Army View)

7.3.3 Data Definitions (Marine View)

The following are the definitions for the data columns contained on the In Transit report for the
Marine view:

e DUIC—This is the deployed unit identification code of the unit. This block is only
displayed when this report is run at the unit level.

e Unit Name—This is the corresponding unit name of the DUIC.

e DTG—Date Time Group prepared. The DTG will be in the following format:
221805ZNOV04. The following is an explanation of this format:

— 22is the day of the month
— 1805 is the military time
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— Zrepresents Zulu
— NOV represents November
— 04 represents the year

Name—This is the name of the individual gain or loss during this reporting period.

SSN/GUID—This is the Social Security number or global unique identifier (GUID)
of the individual in transit.

Person Type—This is the Person Type of the individual gain or loss during this
reporting period. Person Types can be one of the following: DOD Contractor, DOD
Federal Civilian, Foreign National/Military, NAF Employee(AAFES), Non-DOD
Federal Civilian, Other Civilian, Red Cross Worker, or United States Marine, US Air
Force, US Army Soldier, US Coast Guard, or US Navy.

DoD Component—This may contain one of the Department of Defense Component
codes.

Service Component—This is the Service Component of the individual gain or loss
during this reporting period. The Service Component may be one of the following:
National Guard, Regular, Reserve, or Unknown.

Rank—This is the rank of the individual in transit.

PMOS—This is the Primary Military Occupational Specialty of the individual gain
or loss during this reporting period.

DDS—This is the deployed duty status of the individual in transit.
DDS Date—This is the deployed duty status date of the individual in transit.

DDS Reason—This is the deployed duty status reason code of the individual in
transit.

Theater Arrival Date—This is the initial arrival date to the theater for the current
deployment of the individual in transit.

Individual Location—This is the location of the individual in transit.

Location Arrival Date—This is the arrival date to the current location of the
individual in transit.

DUIC—This is the deployed unit identification code of the unit. This column is only
necessary if this report is run at a level that is higher than the unit level.

Draft

November 14, 2005
7-11
FOR OFFICIAL USE ONLY



DTAS Mobile Application User Manual CM No. DTAS-MAUMO0-010-20051114

7.3.4 In-Transit Report Sample (Marine View)

DTAS displays the In-Transit Report in an Excel spreadsheet template as shown in the Marine
view sample below.

SECRET

DTAS IN-TRANSIT REFORT

BUC oW MAME BTG
ccooee | colteen TEST 211536 7SERDS
*Deployed Duty Status
THEATER COCATION
PERSOM|  DeD SERMWICE DOS*| DDSt INDIMIDUAL
MAME | SSNIGUIR | ropE | comPONENT |comPoRENT |FAHK| PMOS DDS* e | RE ason ""‘%i'é“ LOCATION ""*E'l'fé* s

SECRET

Figure 7-7: In-Transit Report Sample (Marine View)

7.4 PERSTAT REPORT
The PERSTAT Report is divided into four parts:

e Part I: Personnel Daily Summary—The report provides a snapshot of personnel
status for your unit, including gains and losses.

e PartII: Loss Summary—The Loss Summary report provides information on the
aggregate number of losses and types of loss on one worksheet and provides a
detailed loss report on a second worksheet.

e Part III: Gains Summary—The Gains Summary report provides information on the
aggregate number of losses and types of loss on one worksheet and provides a
detailed loss report on a second worksheet.
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e Part IV: Remarks—The Remarks section allows you to include comments and
additional information with the report.

There are several business rules that govern the data that are reported on the PERSTAT Report.
Please refer to Business Rules: PERSTAT Report for more information.

7.41 Part I: Personnel Daily Summary

7411 DATA DEFINITIONS
The following are the definitions for the data columns contained on Part | of the PERSTAT
report:

e Report Number—T his sequential number is generated by the unit for management
for all PERSTAT reports.

e DTG—Date Time Group prepared. The DTG will be in the following format:
221805ZNOV04. The following is an explanation of this format:

— 22is the day of the month
— 1805 is the military time

— Zrepresents Zulu

— NOV represents November
— 04 represents the year

e DUIC—This is the deployed unit identification code of the reporting unit.
e Unit Name—This is the corresponding unit name of the DUIC.

e Person Type—The Person Type tracked includes Army—Regular Active, Army-
Army Reserve, Army-National Guard, Army-Unknown, Navy, Air Force, Marines,
Coast Guard, DoD Civilian, Non-DoD Civilian, Contractor, Other Civilian, NAF
Employee (AAFES), Red Cross Worker, Foreign National Civilians, and Foreign
National Military.

e ASGD.—Assigned consists of all personnel assigned to the DUIC.
e Op. Strength—This is the operational strength number for the unit.
e Females—This is a count of the number of female soldiers in the unit.

e KIA—This isa DTAS deployed duty status that represents a casualty who is killed
outright or who dies as a result of wounds received in action.

e WIA—This is a DTAS deployed duty status that represents a casualty who is
wounded, sick, or injured as the result of a battle.

e MIA—This isa DTAS deployed duty status that represents a Soldier who is missing
in action by reason of enemy action.

e Other Losses—This includes the following DTAS deployed duty statuses:

— (1) DO—Dead Other. Personnel who died as a result of an accident or illness not
related to hostilities

— (2) HOS—Hospital. Soldiers/persons admitted to a Mobile Army Surgical
Hospital (MASH), a Combat Army Support Hospital (CASH), or a permanent
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rear Army Medical Hospital, but not reassigned, who are wounded, sick, or
injured not the result of battle.

e Total Losses—This is the sum of the previous four columns on this report: (1) KIA,
(2) WIA, (3) MIA, and (4) Other Losses.

e Gains—This includes personnel who have arrived in the current 12-hour reporting
period as a gain to the DUIC. This is determined by the person’s arrival date and
arrival time to the DUIC.

e Remarks—This block is an editable field, allowing you to manually type in relevant,
useful data.

7.4.1.2 PART |: PERSONNEL DAILY SUMMARY SAMPLE (ARMY VIEW)

A sample of the Personnel Daily Summary worksheet is shown below. The sample shown is for
the Army view.

SECRET
DTAS PERSONNEL STATUS REFPORT
T LR HAEER s ][ TR Pl
2115462 5EF DG CCODEE COLLEEMTEST
PART I - PERSONNEL DAILY SUMMARY

133] 133 40 u] 1] u] u] 1] 1]
12 12 1 i) i] u] u] 1] 1]
a5 35 a u] i u] ] ] ]
2 2 i] u] o] u] u] 1] 1]

5 5 i] 1] i] 1] 1] i] i]

5 5 i] u] 1] u] u] 1] 1]

7 7 1] u] 1] u] u] 1] 1]

5 5 ] o o 1] n 1] 1]

1 1 1 i] i] u] u] 1] 1]

1 1 1] u] 1] u] u] 1] 1]

1 1 1] u] 1] u] u] 1] 1]

1 1 0 o o 1] 1] 1] 1]

1 1 i] u] i] u] u] 1] 1]

1 1 i] i] i] u] u] 1] 1]

5 o i] u] i] u] u] 1] 1]

3 3 0 o o 1] 1] 1] 0
220] 220 50 ] o] u] u] 1] 1]

SECRET

Figure 7-8: Part I: Personnel Daily Summary Sample (Army View)
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7.41.3 PART I: PERSONNEL DAILY SUMMARY SAMPLE (MARINE VIEW)

A sample of the Personnel Daily Summary worksheet is shown below. The sample shown is for
the Marine view.

SECRET
DTAS PEESONNEL STATUS REPORT
2= ) 30 % ] o N[ TR Hen
21172 SEPLS CCODEE COLLEEMTEST
PART I - PERSONNEL DAILY SUMMARY

135 135 40
12 12 1

35 35 i ] ] ] ] n] ]

2 2 ] ] ] ] 0 ] ]

5 5 i] i] i] i] i] [i] i]

5 5 0 0 0 0 0 0 0

7 7 0 0 0 0 0 0 0

5 5 0 0 0 0 0 0 0

1 1 1 ] 0 ] ] ] ]

1 1 0 0 0 0 0 u] 0

1 1 0 0 0 0 0 0 0

1 1 0 0 0 0 0 u] 0

1 1 0 0 0 ] 0 1] 1]

1 1 ] ] 0 ] ] ] ]

5 5 0 ] ] ] 0 ] ]

3 3 ] ] ] ] ] ] ]

2201 220 a0 ] ] ] 0 ] ]

SECRET

Figure 7-9: Part I: Personnel Daily Summary Sample (Marine View)
7.4.2 Part ll: Loss Summary

7.4.2.1 DATA DEFINITIONS FOR LOSS SUMMARY SECTION (ARMY VIEW)

The following are the definitions for the data columns contained on the summary portion of Part
Il of the PERSTAT report:

e DUIC—This is the deployed unit identification code of the reporting unit.
e Unit Name—This is the corresponding unit name of the DUIC.
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e DTG—Date Time Group prepared. The DTG will be in the following format:
221805ZNOV04. The following is an explanation of this format:

— 22is the day of the month
— 1805 is the military time

— Zrepresents Zulu

— NOV represents November
— 04 represents the year

e Person Type—The Person Type is derived from the following data elements: DoD
Contractor, DoD Federal Civilian, Foreign National/Military, NAF Employee
(AAFES), Non-DoD Federal Civilian, Other Civilian, Other US Service Member,
Red Cross Worker, or US Army Soldier.

e PMOS/AOC/Series—This is the primary MOS/AQOC/Series of the individual loss
during this reporting period.

e Grade/SKkill Level—T his represents the grade or skill level for the individual loss
during this reporting period.

e DUIC—This is the deployed unit identification code of the reporting unit.
e Loss Type—This reports on what loss type the individual represents to the unit.
e Total—This is the total number for each line of information

e Remarks—This block is an editable field, allowing you to manually type in relevant,
useful data.

7.4.2.2 PART ll: LOSS SUMMARY SAMPLE (ARMY VIEW)
A sample of the Loss Summary worksheet is shown below.
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SECRET

PART Il - LOSS SUMMARY

Luc UNIT HAME LTG
CChoDEE COLLEEN TEST 21152925 EPOS
P05 | GRADES LOSS
FERSOM TYPE ocy SKILL Luic TOTAL REMARKS
SERIES| LEWEL THEE

Total Losses, All Person Type u]

SECRET

Figure 7-10: Part Il: Loss Summary Sample (Army View)

7.4.2.3 DATA DEFINITIONS FOR LOSS SUMMARY SECTION (MARINE VIEW)
The following are the definitions for the data columns contained on the summary portion of Part
Il of the PERSTAT report:

e DUIC—This is the deployed unit identification code of the reporting unit.

e Unit Name—This is the corresponding unit name of the DUIC.

e DTG—Date Time Group prepared. The DTG will be in the following format:
221805ZNOV04. The following is an explanation of this format:

22 is the day of the month
1805 is the military time

Z represents Zulu

NOV represents November
04 represents the year

e Person Type—Person Types can be one of the following: DOD Contractor, DOD
Federal Civilian, Foreign National/Military, NAF Employee(AAFES), Non-DOD
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Federal Civilian, Other Civilian, Red Cross Worker, or United States Marine, US Air
Force, US Army Soldier, US Coast Guard, or US Navy.

PMOS—This is the Primary Military Occupational Specialty of the individual gain
or loss during this reporting period.

Grade/Skill Level—T his represents the grade or skill level for the individual loss
during this reporting period.

DUIC—This is the deployed unit identification code of the reporting unit.
Loss Type—This reports on what loss type the individual represents to the unit.
Total—This is the total number for each line of information

Remarks—This block is an editable field, allowing you to manually type in relevant,
useful data.

7.4.2.4 PART Il: LOSS SUMMARY SAMPLE (MARINE VIEW)
A sample of the Loss Summary worksheet is shown below.
SECRET
PART Il - LOSS SUMMARY
Duc UNIT NAME DTG
CCDDEE COLLEEN TEST 211830Z5EPDS
N - GRADES LTS fiias il )
PERSON TYPE PMOS LS;:{LEL_ DUIC TYRE TOTAL REMARKS
Totsl Losses, All Parson Type 0
SECRET

Figure 7-11: Part Il: Loss Summary Sample (Marine View)
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7.4.2.5 DATA DEFINITIONS FOR LOSS DETAIL SECTION (ARMY VIEW)

The following are the definitions for the data columns contained on the detail portion of Part 11
of the PERSTAT report:

e DUIC—This is the deployed unit identification code of the unit. This number is only
displayed when this report is run at the unit level.

e Unit Name—This is the corresponding unit name of the DUIC.

e DTG—Date Time Group prepared. The DTG will be in the following format:
221805ZNOV04. The following is an explanation of this format:

— 22is the day of the month
— 1805 is the military time

— Zrepresents Zulu

— NOV represents November
— 04 represents the year

e Name—This is the name of the individual gain or loss during this reporting period.

e SSN/GUID—This is the Social Security number or global unique identifier (GUID)
of the individual gain or loss during this reporting period.

e Person Type—This is the Person Type of the individual gain or loss during this
reporting period. Person Types can be one of the following: DOD Contractor, DOD
Federal Civilian, Foreign National/Military, NAF Employee(AAFES), Non-DOD
Federal Civilian, Other Civilian, Red Cross Worker, or United States Marine, US Air
Force, US Army Soldier, US Coast Guard, or US Navy.

e DoD Component—This may contain one of the Department of Defense Component
codes.

e Service Component—This is the Service Component of the individual gain or loss
during this reporting period. The Service Component may be one of the following:
National Guard, Regular, Reserve, or Unknown.

e Rank—This is the rank of the individual gain or loss.

e PMOS/AOC/Series—This is the primary MOS/AQOC/Series of the individual gain or
loss during this reporting period.

e SQI—This is a list of all Skill Qualification Identifiers (SQIs) of the individual gain
or loss during this reporting period.

e ASI—This is a list of all Additional Skill Identifiers (ASIs) of the individual gain or
loss during this reporting period.

e 2" MOS—This is the secondary MOS of the individual gain or loss during this
reporting period.

e LANG—THhis is list of all language identifiers of the individual gain or loss during
this reporting period.

e Sex—This is the sex of the individual gain or loss during this reporting period.

e DDS—This is the deployed duty status of the individual gain or loss during this
reporting period.
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¢ DDS Reason—This is the deployed duty status reason code of the individual in
transit.

e DDS Date—This is the deployed duty status date of the individual gain or loss during
this reporting period.

e Theater Arrival Date—This is the initial arrival date to the theater for the current
deployment.

e DUIC—This is the deployed unit identification code of the unit. This column is only
necessary if this report is run at a level that is higher than the unit level.

7.4.2.6 Loss DETAIL SAMPLE (ARMY VIEW)
A sample of the Loss detail worksheet is shown below.
SECRET
DTAS GAINS / LOSSES REPORT
DT UNT NAME DTG
[CCDDEE COLLEEN TEST
*LOSSES:
“Losses will be a5 of fe 12 howr reporting period
““Depbyed Cafty Staus
= & i B T T DATE
SECRET
Figure 7-12: Part Il: Loss Detail Sample (Army View)
7.4.2.7 DATA DEFINITIONS FOR LOsSs DETAIL SECTION (MARINE VIEW)

The following are the definitions for the data columns contained on the detail portion of Part 11
of the PERSTAT report:
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DUIC—This is the deployed unit identification code of the unit. This number is only
displayed when this report is run at the unit level.

Unit Name—This is the corresponding unit name of the DUIC.

DTG—Date Time Group prepared. The DTG will be in the following format:
221805ZNOV04. The following is an explanation of this format:

— 22is the day of the month
— 1805 is the military time

— Zrepresents Zulu

— NOV represents November
— 04 represents the year

Name—This is the name of the individual gain or loss during this reporting period.

SSN/GUID—This is the Social Security number or global unique identifier (GUID)
of the individual gain or loss during this reporting period.

Person Type—This is the Person Type of the individual gain or loss during this
reporting period. Person Types can be one of the following: DOD Contractor, DOD
Federal Civilian, Foreign National/Military, NAF Employee(AAFES), Non-DOD
Federal Civilian, Other Civilian, Red Cross Worker, or United States Marine, US Air
Force, US Army Soldier, US Coast Guard, or US Navy.

DoD Component—This may contain one of the Department of Defense Component
codes.

Service Component—This is the Service Component of the individual gain or loss
during this reporting period. The Service Component may be one of the following:
National Guard, Regular, Reserve, or Unknown.

Rank—This is the rank of the individual gain or loss.

PMOS—This is the Primary Military Occupational Specialty of the individual gain
or loss during this reporting period.

SQI—This is a list of all Skill Qualification Identifiers (SQIs) of the individual gain
or loss during this reporting period.

ASI—This is a list of all Additional Skill Identifiers (ASIs) of the individual gain or
loss during this reporting period.

AMOS—This is the Alternate Military Occupational Specialty of the individual gain
or loss during this reporting period.

1°* AMOS—This is the First Alternate Military Occupational Specialty of the
individual gain or loss during this reporting period.

LANG—This is list of all language identifiers of the individual gain or loss during
this reporting period.

Sex—T his is the sex of the individual gain or loss during this reporting period.

DDS—This is the deployed duty status of the individual gain or loss during this
reporting period.

DDS Reason—This is the deployed duty status reason code of the individual in
transit.
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e DDS Date—This is the deployed duty status date of the individual gain or loss during
this reporting period.

e Theater Arrival Date—This is the initial arrival date to the theater for the current
deployment.

e DUIC—This is the deployed unit identification code of the unit. This column is only
necessary if this report is run at a level that is higher than the unit level.

7.4.2.8 Loss DETAIL SAMPLE (MARINE VIEW)
A sample of the Loss detail worksheet is shown below.
SECEET
DTAS GAINS /| LOSSES REPORT
DU Uil T RAME s
OCDDEE COLLEEN TEST
T o e et
“Segiapcd Dut Ste
NALE ssnrgup|FERSON)| D00 | eoniE | mank| s sa a3 anos| M2 |oane |sex|oos| D35 (3057 | oue
g i S a : | DATE
SECEET
Figure 7-13: Part Il: Loss Detail Sample (Marine View)
Draft November 14, 2005
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743 Part lll: Gains Summary

7.4.31 DATA DEFINITIONS FOR GAINS SUMMARY SECTION (ARMY VIEW)
The following are the definitions for the data columns contained on the summary portion of Part
I11 of the PERSTAT report:

e DUIC—This is the deployed unit identification code of the reporting unit.

e Unit Name—This is the corresponding unit name of the DUIC.

e DTG—Date Time Group prepared. The DTG will be in the following format:
221805ZNOV04. The following is an explanation of this format:

— 22is the day of the month
— 1805 is the military time

— Zrepresents Zulu

— NOV represents November
— 04 represents the year

e Person Type—The Person Type is derived from the following data elements: DoD
Contractor, DoD Federal Civilian, Foreign National/Military, NAF Employee
(AAFES), Non-DoD Federal Civilian, Other Civilian, Other US Service Member,
Red Cross Worker, or US Army Soldier.

e PMOS/AOC/Series—This is the primary MOS/AQOC/Series of the individual loss
during this reporting period.

e Grade/SKkill Level—T his represents the grade or skill level for the individual loss
during this reporting period.

e DUIC—This is the deployed unit identification code of the reporting unit.
e Total—This is the total number for each line of information

e Remarks—This block is an editable field, allowing you to manually type in relevant,
useful data.

7.4.3.2 PART lll: GAINS SUMMARY SAMPLE (ARMY VIEW)
A sample of the Gains Summary worksheet is shown below.
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SECRET
PART Il - GAINS SUMMARY
ouic UNIT NAME DTG
CCDDEE COLLEEN TEST 211825F SEFOS
FMOSA| GRADES
FERSON TYFE oo/ KILL DU TOTAL REMARKS
SERIES| LEVEL
Totzsl Gains, All Person Type 0
SECERET
Figure 7-14: Part lll: Gains Summary Sample (Army View)
7.4.3.3 DATA DEFINITIONS FOR GAINS SUMMARY SECTION (MARINE VIEW)

The following are the definitions for the data columns contained on the summary portion of Part
I11 of the PERSTAT report:

DUIC—This is the deployed unit identification code of the reporting unit.
Unit Name—This is the corresponding unit name of the DUIC.

DTG—Date Time Group prepared. The DTG will be in the following format:
221805ZNOV04. The following is an explanation of this format:

— 22is the day of the month
— 1805 is the military time

— Zrepresents Zulu

— NOV represents November
— 04 represents the year

Person Type—The Person Type is derived from the following data elements: DoD
Contractor, DoD Federal Civilian, Foreign National/Military, NAF Employee
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7.4.3.4

A sample of the Gains Summary worksheet is shown below.

(AAFES), Non-DoD Federal Civilian, Other Civilian, Other US Service Member,
Red Cross Worker, or US Army Soldier.

PMOS—This is the Primary Military Occupational Specialty of the individual gain
or loss during this reporting period.

Grade/SKkill Level—T his represents the grade or skill level for the individual loss
during this reporting period.

DUIC—This is the deployed unit identification code of the reporting unit.
Total—This is the total number for each line of information
Remarks—This block is an editable field, allowing you to manually type in relevant,

useful data.

PART lll: GAINS SUMMARY SAMPLE (MARINE VIEW)

SECRET

PART Il - GAINS SUMMARY

ouc
CCDDEE

UNIT NAME
COLLEEN TEST

DTG

2118 20Z SEPDS

PERSON TYPE PMOS KILL

GRADE!S]

LEVEL

DUIC

TOTAL

REMARKS

Total Gains, All Person Typs

SECRET

Figure 7-15: Part lll: Gains Summary Sample (Marine View)
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7.4.3.5 DATA DEFINITIONS FOR GAINS DETAIL SECTION (ARMY VIEW)

The following are the definitions for the data columns contained on the detail portion of Part 11l
of the PERSTAT report:

e DUIC—This is the deployed unit identification code of the unit. This number is only
displayed when this report is run at the unit level.

e Unit Name—This is the corresponding unit name of the DUIC.

e DTG—Date Time Group prepared. The DTG will be in the following format:
221805ZNOV04. The following is an explanation of this format: 221805ZNOV04

— 22is the day of the month
— 1805 is the military time

— Zrepresents Zulu

— NOV represents November
— 04 represents the year

e Name—This is the name of the individual gain or loss during this reporting period.

e SSN/GUID—This is the Social Security number or global unique identifier (GUID)
of the individual gain or loss during this reporting period.

e Person Type—This is the Person Type of the individual gain or loss during this
reporting period. Person Types can be one of the following: DOD Contractor, DOD
Federal Civilian, Foreign National/Military, NAF Employee(AAFES), Non-DOD
Federal Civilian, Other Civilian, Red Cross Worker, or United States Marine, US Air
Force, US Army Soldier, US Coast Guard, or US Navy.

e DoD Component—This may contain one of the Department of Defense Component
codes.

e Service Component—This is the Service Component of the individual gain or loss
during this reporting period. The Service Component may be one of the following:
National Guard, Regular, Reserve, or Unknown.

e Rank—This is the rank of the individual gain or loss.

e PMOS/AOC/Series—This is the primary MOS/AQOC/Series of the individual gain or
loss during this reporting period.

e SQI—This is a list of all Skill Qualification Identifiers (SQIs) of the individual gain
or loss during this reporting period.

e ASI—This is a list of all Additional Skill Identifiers (ASIs) of the individual gain or
loss during this reporting period.

e 2" MOS—This is the secondary MOS of the individual gain or loss during this
reporting period.

e LANG—THhis is list of all language identifiers of the individual gain or loss during
this reporting period.

e Sex—This is the sex of the individual gain or loss during this reporting period.

e DDS—This is the deployed duty status of the individual gain or loss during this
reporting period.
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e DDS Reason—This is the deployed duty status reason code of the individual.

e DDS Date—This is the deployed duty status date of the individual gain or loss during
this reporting period.

e Theater Arrival Date—This is the initial arrival date to the theater for the current
deployment.

e DUIC—This is the deployed unit identification code of the unit. This column is only
necessary if this report is run at a level that is higher than the unit level.

7.4.3.6 GAINS DETAIL SAMPLE (ARMY VIEW)
A sample of the Gains detail worksheet is shown below.

SECRET
DTAS GAINS / LOSSES REPORT
TG URIT FANE oTG
CCODEE COLLEEN TEST
GAMS:
*Galns wil be as ofthe 12 hour 2poriing perbd
““Deployed DRy STaus
i ESHEESE DD sERice (.o [Prosmocy o e 20|, el el | DOS DOS™ :';’Tf:‘ B
o GUAD | TYPE | COMPONENT |COMPONENT SERES s = (1] taiand REASOM | DATE 34.1\'= i
SECRET

Figure 7-16: Part lll: Gains Detail Sample (Army View)

7.4.3.7 DATA DEFINITIONS FOR GAINS DETAIL SECTION (MARINE VIEW)
The following are the definitions for the data columns contained on the detail portion of Part 11l
of the PERSTAT report:

e DUIC—This is the deployed unit identification code of the unit. This number is only
displayed when this report is run at the unit level.
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Unit Name—This is the corresponding unit name of the DUIC.

DTG—Date Time Group prepared. The DTG will be in the following format:
221805ZNOV04. The following is an explanation of this format:

— 22is the day of the month
— 1805 is the military time

— Zrepresents Zulu

— NOV represents November
— 04 represents the year

Name—This is the name of the individual gain or loss during this reporting period.

SSN/GUID—This is the Social Security number or global unique identifier (GUID)
of the individual gain or loss during this reporting period.

Person Type—This is the Person Type of the individual gain or loss during this
reporting period. Person Types can be one of the following: DOD Contractor, DOD
Federal Civilian, Foreign National/Military, NAF Employee(AAFES), Non-DOD
Federal Civilian, Other Civilian, Red Cross Worker, or United States Marine, US Air
Force, US Army Soldier, US Coast Guard, or US Navy.

DoD Component—This may contain one of the Department of Defense Component
codes.

Service Component—This is the Service Component of the individual gain or loss
during this reporting period. The Service Component may be one of the following:
National Guard, Regular, Reserve, or Unknown.

Rank—This is the rank of the individual gain or loss.

PMOS—This is the Primary Military Occupational Specialty of the individual gain
or loss during this reporting period.

SQI—This is a list of all Skill Qualification Identifiers (SQIs) of the individual gain
or loss during this reporting period.

ASI—This is a list of all Additional Skill Identifiers (ASIs) of the individual gain or
loss during this reporting period.

AMOS—This is the Alternate Military Occupational Specialty of the individual gain
or loss during this reporting period.

1 AMOS—This is the First Alternate Military Occupational Specialty of the
individual gain or loss during this reporting period.

LANG—This is list of all language identifiers of the individual gain or loss during
this reporting period.

Sex—This is the sex of the individual gain or loss during this reporting period.

DDS—This is the deployed duty status of the individual gain or loss during this
reporting period.

DDS Reason—This is the deployed duty status reason code of the individual.

DDS Date—This is the deployed duty status date of the individual gain or loss during
this reporting period.
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Theater Arrival Date—This is the initial arrival date to the theater for the current
deployment.

DUIC—This is the deployed unit identification code of the unit. This column is only
necessary if this report is run at a level that is higher than the unit level.

7.4.3.8 GAINS DETAIL SAMPLE (MARINE VIEW)
A sample of the Gains detail worksheet for the Marine view is shown below.
SECFET
DTAS GAINS | LOSSES REPORT
¥ e LT ME (]
CCODEE COLLEEN TEST
GA INS:
“Eans wil be 25 oF T2 1 howr Epoiing perbd
“Depioyed Doy Status e
NAKE ssneun || | o | FAtK | Paos 50 e ancs| o | Lans|ssx oos| DE 1S A-g_j_-‘ U
SECFET
Figure 7-17: Part lll: Gains Detail Sample (Marine View)
7.4.4 Part IV: Remarks

This block is an editable field, allowing you to manually type in relevant, useful data.

7.4.41

PART IV: REMARKS SAMPLE

A sample of the Remarks worksheet is shown below.
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SECEET

PART IV - REMARK S

SECEET

Figure 7-18: Part IV: Remarks Sample

7.4.5 Business Rules: PERSTAT Report
The following business rules apply to the PERSTAT Report:

Part I: Personnel Daily Summary

e Only the Missing—Missing in Action (MIS-MIA) duty status is reported in the MIA
column.

e The Other Losses column reports the following duty statuses:
— Confined by Military Authorities (CMA)
— Convalescent Leave (CLV)
— Death Other (DO)
— Duty Status Where Abouts Unknown (DWU)
— Hospitalized (Battle Incurred) (HOW)
— Hospitalized (Nonbattle Incurred) (HOS)
— In-Transit (TRA)
— Missing—Absent Without Leave (MIS-AWL)
— Missing—Beleaguered (MIS-BGD)
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— Missing-Besieged (MIS-BSG)
— Missing—Captured (MIS-CAP)
— Missing-Detained (MIS-DTN)
— Missing-Interned (MIS-INT)
— Missing—Missing (MIS-MIS)
— Redeployed (RED)

— Rest and Recuperation (RNR)

After 12 hours, the following permanent losses are not counted against assigned strength
and Female columns:

— Death Other (DO)

— Killed in Action (KIA)

— Redeployed-Dropped from Rolls (RED-DFR)

— Redeployed-Hospitalized (Battle Incurred) (RED-HOW)

— Redeployed-Hospitalized (Nonbattle Incurred) (RED-HOS)
— Redeployed-Mission Complete (RED-MIC)

Part II: Loss Summary

Losses reported on both the Loss Summary worksheet and the Losses worksheet include
all duty status changes except Present for Duty (PDY) and Temporary Duty (TDY).

Losses include delete actions that originate from the Mobile and Theater systems.
The Update DUIC function reports a loss for the losing DUIC.
The data reported on the Loss Summary is only for the preceding 12-hour period.

Part III: Gains Summary

7.5

7.5.1

The data reported on the Gains Summary is only for the preceding 12-hour period.
The Update DUIC function reports a gain for the gaining DUIC.

Unit Roster

Data Definitions (Army View)

The following are the definitions for the data columns contained on the Unit Roster:

e Name—This is the name of the individual.

e SSN/GUID—This is the Social Security number or global unique identifier (GUID)
of the individual.

e Person Type—This is the Person Type of the individual. Person Types can be one of
the following: DOD Contractor, DOD Federal Civilian, Foreign National/Military,
NAF Employee(AAFES), Non-DOD Federal Civilian, Other Civilian, Red Cross
Worker, or United States Marine, US Air Force, US Army Soldier, US Coast Guard,
or US Navy.
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e DoD Component—This may contain one of the Department of Defense Component
codes.

e Service Component—This is the Service Component of the individual. The Service
Component may be one of the following: National Guard, Regular, Reserve, or
Unknown.

e Rank—This is the rank of the individual.

e MOS/AOC/Series—This is the MOS/AOC/Series of the individual.

e SQI—This is a list of all Skill Qualification Identifiers (SQIs) of the individual.
e ASI—This is a list of all Additional Skill Identifiers (ASIs) of the individual.

e LANG—THhis is list of all language identifiers of the individual.

e DUIC—This is the deployed unit identification code of the unit.

e Deployed Unit Name (DUIC)—This is the deployed unit name of the unit for the
individual.

e HUIC—This is the UIC of the unit the person is assigned to at his or her home
station.

e Assigned Unit Name (HUIC)—This is the assigned unit name of the unit for the
individual at his or her home station.

e MPC—This is the Military Personnel Class code for the soldier and other service
member.

e DDS—This is the deployed duty status of the individual.
e DDS Reason—This is the deployed duty status reason code of the individual.
e DDS Date—This is the deployed duty status date of the individual.

e Theater Arrival Date—This is the initial arrival date to the theater for the current
deployment.

e Phys. Loc.—This is the physical location of the individual.

e Location Arrival Date—This is the arrival date to the current location of the
individual.

e Sex—This is the sex of the individual.

e HOR City—This is the home of record (HOR) city for the individual.

e HOR State—This is the home of record (HOR) State for the individual.

e Marital Status—This is the marital status of the individual.

e Military Education Level—This is the military education level of the individual.
e Religious Denomination—This is the religious denomination of the individual.

e Race—This is the race population code for the individual.

e Ethnic Group—This is the code for the individual’s ethnic group.

e Blood Type—This is the blood type of the individual.

e Date of Birth—This is the date of birth for the individual.

e Security Clearance Level—This is the security clearance level for the individual.
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e Operation Name—The title of the operation to which the individual is assigned.

7.5.2 Unit Roster Report Sample (Army View)

DTAS displays the Unit Roster Report in an Excel spreadsheet template. Because of the width
of the report, you may want to print the report as two pages, as shown in the sample below, in
order to produce a legible report.
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Figure 7-19: Unit Roster—Left-Hand Side (Army View)
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7.5.3

Figure 7-20: Unit Roster—Right-Hand Side (Army View)

Data Definitions (Marine View)

The following are the definitions for the data columns contained on the Unit Roster:

Name—This is the name of the individual.

SSN/GUID—This is the Social Security number or global unique identifier (GUID)
of the individual.

Person Type—This is the Person Type of the individual. Person Types can be one of
the following: DOD Contractor, DOD Federal Civilian, Foreign National/Military,
NAF Employee(AAFES), Non-DOD Federal Civilian, Other Civilian, Red Cross
Worker, or United States Marine, US Air Force, US Army Soldier, US Coast Guard,
or US Navy.

DoD Component—This may contain one of the Department of Defense Component
codes.

Service Component—This is the Service Component of the individual. The Service
Component may be one of the following: National Guard, Regular, Reserve, or
Unknown.

Rank—This is the rank of the individual.

PMOS—This is the Primary Military Occupational Specialty of the individual gain
or loss during this reporting period.

AMOS—This is the Alternate Military Occupational Specialty of the individual gain
or loss during this reporting period.
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e 1" AMOS—This is the First Alternate Military Occupational Specialty of the
individual gain or loss during this reporting period.

e LANG—THhis is list of all language identifiers of the individual.
e DUIC—This is the deployed unit identification code of the unit.

e Deployed Unit Name (DUIC)—This is the deployed unit name of the unit for the
individual.

e PRUC—This is the Primary Reporting Unit Code of the individual.
e PRUC Unit Name—This is the Primary Reporting Unit name of the individual.

e Officer/Enlisted—This denotes whether the individual is an officer or enlisted
personnel.

e DDS—This is the deployed duty status of the individual.
e DDS Reason—This is the deployed duty status reason code of the individual.
e DDS Date—This is the deployed duty status date of the individual.

e Theater Arrival Date—This is the initial arrival date to the theater for the current
deployment.

e Individual Location—This is the location of the individual.

e Location Arrival Date—This is the arrival date to the current location of the
individual.

e Sex—This is the sex of the individual.

e HOR City—This is the home of record (HOR) city for the individual.

e HOR State—This is the home of record (HOR) State for the individual.

e Marital Status—This is the marital status of the individual.

e Military Education Level—This is the military education level of the individual.
e Religious Denomination—This is the religious denomination of the individual.
e Race—This is the race population code for the individual.

e Ethnic Group—This is the code for the individual’s ethnic group.

e Blood Type—This is the blood type of the individual.

e Date of Birth—This is the date of birth for the individual.

e OPID—This is the Operational Identifier for the individual.

e MAGTF—This is the Marine Air-Ground Task Force to which the individual is
assigned.

e Security Clearance Level—This is the security clearance level for the individual.

e Operation Name—The title of the operation to which the individual is assigned.

7.5.4 Unit Roster Report Sample (Marine View)

DTAS displays the Unit Roster Report in an Excel spreadsheet template. Because of the width
of the report, you may want to print the report as two pages, as shown in the sample below, in
order to produce a legible report.
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Figure 7-21: Unit Roster—Left-Hand Side (Marine View)
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Figure 7-22: Unit Roster—Right-Hand Side (Marine View)
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8. MANAGEMENT TAB

The Management tab allows you to manage personal equipment issued to an individual, such as
night vision goggles (NVGs) and weapons. To update information for an individual, perform the
following steps:

1. Place the cursor in the column you wish to update for the applicable individual and click the
left mouse button. For example, to update a serial number for night vision goggles, place the
cursor in the NVG Serial # column.

Deployed Theater Accountability Software (DTAS)
File View Tools Help

F‘eople] Loc:ationsl Reports  Management ]

Include Sub
Units

CCDDEE COLLE|

~

Last Name First Name | S5N NVG Type MVG Serial # | Weapon Type | Serial #1 Weapon «
»  |ACOSTA  ANGELA

| ADKISSON MARGQUIS

|AHERN COLIN

|ALLEN DENA

| AMOAKOH MARY

|ANDERSON  ERIK

_;ANDEHSDN MARCUS

| AMEST STEPHEN
APGER ROBERT
|ARRINGTON  LAVAR
|AVERY JASON
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|BAILEY THOMAS

|BAMKSEVAN  JASON
|BARMES DAVID
|BASNETT JARROD
|BEEEE PATRICK

|[FFIKOFFR  THOMAS B
£ | 3 »
Save

-ﬁxMEF{\nﬂ'nd % Synchronization Complete - 9/23/°2005 2:25:23 PFM ;ﬁueued Messages: 0

Figure 8—1: Management Tab

2. Enter the data you wish to update.
3. When you have finished entering the data, click Save to save the changes.
4. DTAS displays a confirmation message if the update is successful.
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\:5) Save has completed successfully,

Figure 8-2: Save Confirmation Message

Note: If the system detects that there have been no updates, DTAS displays the “There are no
updates to perform” message when you click the Update button.

Management EJ

\5) There are no updates to perform.

Figure 8-3: No Updates Message
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9. DCIPS-FORWARD EXPORT

The DTAS Mobile application provides a refresh of data used in the Defense Casualty
Information Processing System Forward (DCIPS-Forward). DCIPS-Forward is a casualty
reporting system that is designed to work in situations where e-mail or Internet access is
unavailable. The system allows users to create casualty reports locally and, when e-mail access
is restored, send the information to the casualty office for upload to the main DCIPS database.

The DTAS DCIPS-Forward refresh process runs every 4 hours and is transparent. DTAS
exports the data to the df_personnel.mdb MS Access database file. DTAS exports data for all
personnel contained on your local DTAS database. The data elements exported include the
following:

e SSN

Last Name
First Name
Middle Name
Rank

Unit

UlC
PMOS
PEBD
BASD
Grade

Once the export process is complete, you must then copy the df_personnel.mdb file to the
directory in which DCIPS-Forward is located on your PC. You can turn the process off by
changing the job enabled setting in the DCIPS_Export.ini file from JOB_ENABLED=true to
JOB_ENABLED=false. Note: The JOB_ENABLED keyword is case-sensitive. If the refresh
process fails, DTAS creates a log file.

Refer to the USMC DCIPS Forward Support Page for additional information and directions on
how to install DCIPS-Forward. The site is located at
https://143.84.96.35/dcips/usmc/dcipsforward/usmc_dcipsforward.htm.

Information on DCIPS-Forward for Army personnel can be found at http://usassi-
www.army.mil/agobc/AG%20L essons/DCIPS/DCIPS.htm.
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The following abbreviations and acronyms are used in this document:

Abbreviation/Acronym Definition

1SG/CO First Sergeant/Company

1" AMOS First Alternate Military Occupational Specialty

AAFES Army and Air Force Exchange Service

AFADBD Armed Forces Active Duty Base Date

AOC Area of Concentration

AMOS Alternate Military Occupational Specialty

APOD Air Port of Debarkation

APOE Air Port of Embarkation

ASI Additional Skills Identifier

BASD Basic Active Service Date

CONUS Continental United States

CSv Comma Separated Values

DCIPS-Forward Defense Casualty Information Processing System Forward

DDS Deployed Duty Status

DMDC Defense Manpower Data Center

DoD Department of Defense

DTAS Deployed Theater Accountability Software

DTG Date Time Group

DUIC Deployed Unit Identification Code

EAS End of Active Service

eMILPO Electronic Military Personnel Office

HAG High Assurance Guard

HOR Home of Record

HUIC Home UIC

JPERSTAT Joint Personnel Status

KIA Killed in Action

LANG Language

MAGTF Marine Air-Ground Task Force

M Middle Initial

MIA Missing in Action

MOS Military Occupational Specialty

MOS/AOC Military Occupational Specialty/Area of Concentration

MPC Military Personnel Class

MS Microsoft

NAF Non-Appropriated Fund

NVG Night Vision Goggle

OCONUS Outside the Continental United States

ODSE Operational Data Store Enterprise

OPID Operational Identifier

PC Personal Computer

PEBD Pay Entry Base Date

PERSTAT Personnel Status

PMOS Primary Military Occupational Specialty
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Abbreviation/Acronym

Definition

POC Point of Contact
PRUC Primary Reporting Unit Code
R&R Rest And Recuperation
RUC Reporting Unit Code
SQl Skill Qualification Indicator
SSN Social Security Number
SSN/GUID Social Security Number/Global Unique Identifier
TPS Tactical Personnel System
TRN Transfer File
TRUC Temporary Reporting Unit Code
uIC Unit Identification Code
ULN Unit Line Number
US United States
USMC U.S. Marine Corps
WIA Wounded in Action
XML Extensible Markup Language
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